


Using Ubuntu MATE 
And Its Applications

Ubuntu MATE 22.04 LTS Edition

Copyright 2017-2022 Larry Bushey. Some rights reserved. 

Fifth Edition

Published at Amazon by Larry Bushey

This work is licensed under the Creative Commons
Attribution 4.0 International License. 

To view a copy of this license, visit
http://creativecommons.org/licenses/by/4.0/, or send a letter

to Creative Commons, 171 Second Street, Suite 300, 
San Francisco, California, 94105, USA.

We permit and even encourage you to distribute a copy of
this book to colleagues, friends, family, and anyone else who

might be interested. 

- 2 -



Table of Contents
About This Book..........................................................................7

Creative Commons....................................................8
Attribution And Credits..............................................8

Introduction.................................................................................9

Ubuntu MATE Is Linux!............................................10
Background Basics...................................................................12

Ubuntu MATE Works For You, Not The Other Way Around
.........................................................................................12

Modern And Full-Featured.......................................14
Pre-Configured Yet Flexible.....................................14
Built-In Security.......................................................14

How To Personalize Ubuntu MATE..........................................15

How To Choose And Change Panel Layouts......................17
Familiar (Ubuntu MATE) Layout...............................18
Traditional Layout...................................................19
Contemporary Layout..............................................20
Redmond Layout.....................................................21
Cupertino Layout.....................................................22
Pantheon Layout.....................................................23
Mutiny Layout..........................................................24
How To Customize And Save Your Own Panel Layout

..........................................................................25
How To Change The Location Of Window Controls. .26

How To Change The Theme.................................................27
How To Change The Desktop Background.........................28
How To Adjust Date And Time Settings..............................29
How To Modify The Panels...................................................30
How To Adjust Desktop, Panel, And Menu Icons...............32

How To Create Application Icons From The Menus..32

- 3 -



How To Create System Icons Using MATE Tweak....34
How To Create Launcher Icons In The Menu............35

How To Manage Your Monitor's Settings............................38
How To Change The Display Resolution..................38
How To Connect Multiple Displays...........................39
How To Scale High-Resolution Monitors..................41

How To Manage Power Settings..........................................43
Strategies For Improving Battery Life......................43

How To Optimize The Screensaver.....................................49
How To Adjust The Screensaver Settings................50

How To Add Software To Ubuntu MATE..................................51

Installing Trusted Linux Applications.................................51
Trusted Sources......................................................52
Software Boutique...................................................53
How To Install Applications Using The Software 

Boutique............................................................54
How To Install Other Software Center Applications. 56

How To Use The Applications..................................................58

Ubuntu MATE Welcome.......................................................58
Getting Started: Updates & Extras..........................59
Getting Started: Drivers..........................................60
Getting Started: Setting Up Printers........................62
Getting Started: Additional Utilities.........................63
Getting Started: System Specifications...................64

The Ubuntu MATE Guide......................................................66
How To Search For Help In The Guide.....................67

Accessibility Software..........................................................68
Enabling Accessibility At Startup.............................69
Orca Screen Reader................................................70
How To Use Onboard, The On-Screen Keyboard.....72
How To Use The Screen Magnifier...........................73
How To Enable Mobility Preferences........................74

How To Use The MATE Desktop's Applications.................76

- 4 -



File Browser (Caja)..................................................76
Text Editor (Pluma)..................................................79
MATE Calculator......................................................82
Archive Manager (Engrampa)..................................83
Image Viewer (Eye of MATE)...................................85
Document Viewer (Atril)..........................................87
MATE Disk Usage Analyzer (Baobab).......................89
MATE System Monitor..............................................90
MATE Terminal........................................................92
Control Center.........................................................98

How To Use Ubuntu MATE's Applications..........................99
How To Use Ubuntu MATE's Productivity Applications

..........................................................................99
How To Use Ubuntu MATE's Document Management 

Applications.....................................................111
How To Use The Entertainment Applications.........114
How To Use Ubuntu MATE's Security Applications.118
How To Update Your Ubuntu MATE And Its 

Applications.....................................................125
Appendices..............................................................................129

Appendix A: How To Use Keyboard Shortcuts................129
Do You Need To Enable The Super Key?...............130
Common Application Shortcuts.............................131
Window Shortcuts.................................................132
Desktop Shortcuts.................................................133
How To Create Custom Keyboard Shortcuts..........133

Appendix B: How To Try And Install Ubuntu MATE.........135
How To Create Installation Media..........................135
How To Prepare For Installation.............................136
How To Try And Install Ubuntu MATE....................138

Appendix C: How To Submit Feedback On Problems.....142
 How To Report Bugs In Ubuntu MATE...................142

Appendix D: Why Computer Users Switch To Linux.......146

- 5 -



Why Users Switch From Windows..........................146
Why Users Switch From macOS.............................147
Why Users Switch From ChromeOS.......................148

Appendix E: Linuxes Key Differences...............................149
What Are The Difference Between Linux Distributions

If They Are All Linux?.......................................149
What Kind Of Computer User?...............................150
What Software Is Pre-Installed?.............................150
Which Desktop Environment?................................151
Which Package Format And Package Manager?....151
Which Display Servers?.........................................152
Summary...............................................................153

Appendix F: Trusted Sources And Software Repositories 
Explained......................................................................154

Software Boutique.................................................154
Apt And Apt-Get....................................................154
Software Updater..................................................154
Add-On Software Management Applications.........155

Appendix G: Additional Resources...................................156
Ubuntu MATE Website And Community.................156
Ubuntu MATE Guide Online...................................156
Going Linux...........................................................157

Appendix H: About The Author.........................................158
Other Publications By This Author.........................158
How To Contact The Author:..................................159

- 6 -



About This Book
This fifth edition includes the new, updated and improved 
themes, applications, and features included in Ubuntu 
MATE's 22.04 LTS (Long Term Support) release. The 22.04 
release is the culmination of two years of continual 
improvement to Ubuntu MATE, Ubuntu, and the MATE 
Desktop.

Here you'll find explanations and how-to guides for computer
users who want to learn how to use Ubuntu MATE and its 
applications to get things done. Reading this book can help 
you build your confidence and competence in using Ubuntu 
MATE. You will be taken through the practical steps required
to perform specific tasks using Ubuntu MATE. This book is 
designed to help frame the picture of what Ubuntu MATE 
can actually do.

This book contains these main sections:
 Introduction 

 A high-level explanation of Ubuntu MATE and Linux
 Background Basics

 An explanation of why to choose Ubuntu MATE
 How To Personalize Ubuntu MATE

 How-to guides for making each major capability of Ubuntu 
MATE your own

 How To Add Software To Ubuntu MATE
 How to obtain and install additional applications

 How To Use The Applications
 How to get started with each of the major applications 

included with Ubuntu MATE
 Appendices

 Eight more how-to guides and explanations for the more 
detail-oriented reader

If you or someone you know needs help getting started with 
Ubuntu MATE and wants a basic introduction then you might
consider the latest edition of my book, "Ubuntu MATE: 
Upgrading from Windows or macOS," listed in Appendix H. 

It helps a beginner achieve basic competence with Ubuntu 
MATE, so that they can go on to use it for their own 
purposes. 

- 7 -



Creative Commons

 You can share this book with anyone and make 
as many copies as you like. This book is licensed under a 
Creative Commons Attribution 4.0 International License. For 
more about copying and sharing this book, visit 
http://creativecommons.org/licenses/by/4.0/.

Attribution And Credits
 Thank you to Martin Wimpress and the Ubuntu MATE 

team and community for the inspiration to expand on 
the Ubuntu MATE Guide that I authored for inclusion 
with the operating system. This book represents that 
expansion.

 Special thanks to Bill Smith, co-host of the Going 
Linux Podcast. Without his contributions and creative 
ideas, this book would not have been possible.

 Some content has been adapted from the Ubuntu 
MATE Guide, provided within the Ubuntu MATE Linux
distribution.

 Some content has been adapted from the MATE 
Desktop User Guide, published by the MATE 
Documentation Project.

 Some content has been adapted from the Going Linux
website and podcast, https://goinglinux.com

 Ubuntu is a trademark of Canonical Ltd.
 All other trademarks are the property of their 

respective owners.
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Introduction

 As a computer user, you likely already know that 
an operating system (OS) is the core software that runs your
computer. Ubuntu MATE is an operating system that you'll 
find is more similar to than different from Microsoft Windows,
Apple macOS, and Google Chrome OS. Ubuntu MATE is a 
distribution (variation or flavor) of Linux designed for the 
beginner, average, and advanced computer user alike. 

If you are new to Ubuntu MATE, or only casually acquainted 
with Linux-based distributions, it can take very little effort to 
understand how Ubuntu MATE compares with other 
software you have used. This book will help demystify 
Ubuntu MATE for new-comers and provide a how-to guide 
for everyone. 

Ubuntu MATE Linux is a supported and official "flavor" of 
Ubuntu, the most widely deployed Linux-based desktop 
operating system in the world. Ubuntu, pronounced 
oŏ'boŏntoō, is developed by Canonical, Ltd. and you can get
it in a number of different flavors, each coming with its own 
desktop environment. 

As the name suggests, Ubuntu MATE provides you with the 
MATE Desktop for Linux along with the Ubuntu base 
operating system. The name "MATE" is pronounced "Mah-
Tay" (not "Mayt") and comes from the name of the yerba 
maté plant, a species of holly native to South America. In 
keeping with that theme, many of the applications provided 
with MATE have Spanish sounding names like Pluma (the 
text editor) and Caja (the file manager). 

Note: The majority of the examples and screenshots provided in 
this book are from the most recent version of Ubuntu MATE, 
release 22.04 LTS. They were created entirely using Ubuntu 
MATE and its applications.
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Ubuntu MATE Is Linux!

 The awareness, popularity, and use of Linux has been 
increasing steadily. Once you become aware that there is 
dependable, secure, capable, and modern software to run 
your computer that rivals all others, you will want to apply 
what you already know and try the Linux operating system. 
You may already be using a member of the Unix/Linux 
family: Linux, Android, ChromeOS, BSD, Azure Sphere, or 
even macOS. If so, you are likely looking for new ways to 
optimize this technology for the way you work.

You may have been attracted to Linux because it is free and 
you can run it on almost any computer hardware but I bet 
you'll continue to use Ubuntu MATE Linux because it is 
much like your previous computer's software, only better. By 
"better" I mean that it provides a modern but familiar user 
experience, it is easy to understand and use, it's designed 
with security built-in and with protection from viruses and 
spyware included. To continue using it after you've tried it, I 
know you will want to have all of those features included and
upgradeable at no additional charge. Of course you'll want it 
all to "just work" with minimal or no maintenance -- automatic
security updates and software upgrades for both the 
operating system and all of your installed applications. I'm 
sure you don't mind paying for software, but you prefer the 
"try before you buy" philosophy. Ubuntu MATE gives you all 
of that and more!

While I often recommend Ubuntu MATE for users who have 
migrated from Windows, macOS, or ChromeOS, it is also an 
excellent choice for any kind of computer user, from casual 
home user to professional software developer. That's 
because of its beautiful, modern, and functionally thought-
out design. Ubuntu MATE is capable enough for even the 
most experienced computer user because, well, it's Linux! It 
has the power of every other Linux distribution built-in. 
Simply put, it provides a powerful and practical alternative to 
other software that can run on your computer.
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With that in mind, this book is written from the perspective 
that Ubuntu MATE is a typical modern Linux for the average 
computer user. 

Let's assume that our fictional "average user" is someone 
who, at a minimum, needs to browse the Internet, check 
email, use a text editor or word processor, and maybe read 
and store document files. Let's also include in the list viewing
and editing photos, watching videos, and listening to music 
and podcasts. As soon as it's installed, Ubuntu MATE 
provides you with applications that enable all of those 
capabilities. Whether you are new to Ubuntu MATE, 
upgrading from Windows or macOS, or just thinking about 
moving to Linux, this book will provide you with practical 
guidance on how you can use Ubuntu MATE and its 
applications to do your  day-to-day work. 

Assumptions about how you will use this book:
1. Your will decide what you want to know. You simply need to 
be shown what Ubuntu MATE can do.
2. You are applying knowledge you already have as a computer 
user.
3. You have sufficient competence to get yourself into and out of 
trouble.
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Background Basics

 Perhaps out of frustration you'd rather spend a little 
time to learn how to personalize Ubuntu MATE than hunt 
down one more Windows hack or Apple workaround to 
prevent your computer from doing things you don't want it to 
be doing. Maybe you just want to use your computer to get 
things done without advertising or interruption. Maybe you 
believe your computer should be doing work for you, and not
the other way around. Ubuntu MATE is designed to make all 
of that a reality! See Appendix D to discover more 
information about why users switch to Ubuntu MATE from 
other operating systems like Windows, macOS and 
ChromeOS.

Ubuntu MATE Works For You, Not The 
Other Way Around
Often, neither Microsoft nor Apple will let you upgrade that 
perfectly-functioning computer hardware you purchased a 
few years ago, even though it has almost the same specs as
the newest computers available today. You are told your 
current hardware 'isn't capable' of running modern software 
or ‘isn’t compatible’ with the latest security updates. 
Insultingly, your Windows computer that you've been told is 
incapable of running the most modern and secure version of 
the software keeps trying to force you to upgrade to the 
incompatible version! 

And the security concerns? Read on to see how Ubuntu 
MATE is more secure and better-supported than other 
operating systems. Although third-party antivirus software is 
available for Linux, it is most frequently used to scan for 
vulnerabilities in files that are being shared with or by 
Windows users. 
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By design, Ubuntu MATE makes it difficult for viruses, 
rootkits, and other malware to be installed and run without 
your knowledge and conscious intervention.

Ubuntu MATE receives updates continuously and the 
updates include security patches for Ubuntu MATE and its 
installed applications, all provided on the same frequent 
schedule. This ensures that you have the latest protection 
for all of your computer's software right away. Ubuntu 
MATE's update system is designed to stay out of your way. 
You choose whether you want to have updates occur 
automatically or manually. Also, it is very rare that you 
receive an update for Ubuntu MATE or its installed 
applications that requires disruptive rebooting!
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Modern And Full-Featured

When you try Ubuntu MATE, you'll find that it is a free, full-
featured, and modern computer operating system, with an 
attractive and easy to understand user interface. Its update 
manager keeps both the operating system itself and all of its 
installed applications updated to the most current, most 
secure release. Ubuntu MATE is more secure and better-
supported than operating systems that come pre-installed on
most personal computer hardware today. With modest 
hardware requirements, Ubuntu MATE is suitable for modern
workstations and laptops, single board computers, and older 
hardware alike. Ubuntu MATE makes modern computers 
fast and old computers usable.

Pre-Configured Yet Flexible

Using Ubuntu MATE provides you with the freedom to run a 
complete, full-featured operating system, pre-configured with
most, if not all, of the applications you will need for your daily
computing. Or you can change anything about the way it 
looks, the way it works, or the applications it runs to suit your
taste.

Built-In Security

Ubuntu MATE is designed with security in mind. Unlike 
operating systems that update only once a month, Ubuntu 
MATE keeps you safe and secure by receiving updates 
continuously. The easy updates include security patches for 
Ubuntu MATE and all of its components. Security updates 
for its installed applications are also provided on the same 
schedule. This ensures that you have the latest protection 
for all of your computer's software as soon as it's available 
and for as long as you keep it up to date!
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How To Personalize Ubuntu 
MATE

 Although you can do some basic tweaking out of the 
box with other operating systems, Ubuntu MATE is infinitely 
more configurable than ChromeOS, macOS, or Windows. 
Sure you can purchase add-on software to personalize your 
Windows or Mac desktop, but Ubuntu MATE provides the 
customization tools built right in, with even more apps and 
utilities just a few clicks away in the software repositories. 
(Repositories are like a free software store.) What makes 
Ubuntu MATE so much more flexible is that it has been 
designed to be customizable.

So, what can you do with Ubuntu MATE? Start simple and 
change the background image (desktop wallpaper), or get 
adventurous and alter the menu position, or even make your 
desktop a virtual "dashboard" for displaying the health and 
performance of your computer's hardware. Detailing all of 
the possibilities for customization would fill an entire book, so
this section will simply give you some ideas as to what can 
be done, and it will be up to you to explore on your own how 
you can configure your system to make it look and work the 
way that best suits your workflow and your personal style. 
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As you learn about Ubuntu MATE, you might like the default 
settings and configuration that it provides or you might find it 
more comfortable to put things where you were used to 
finding them on your previous system. You are free to make 
it your own.

Ubuntu MATE provides the unique MATE Tweak tool to do 
just that -- to transform the look and feel of your computer. 
The MATE Tweak application is found in the Ubuntu MATE 
menus at Menu* ► Control Center ► MATE Tweak and 
can be used to quickly change how things look and feel. You
can even make Ubuntu MATE look and work like other 
popular operating systems if that's what you want. Or you 
can give it a unique and distinctive look of its own so that 
anyone looking at your screen can tell you are using 
something beautiful and different!

* Note: Your first Ubuntu MATE menu choice depends on which 
of the Panel Layouts you have selected. If you chose the default 
Familiar (Ubuntu-MATE) Layout, the first menu item is “Menu". It 
is also the first menu item for Contemporary Layout, Redmond 
Layout, Mutiny Layout, and Pantheon Layout. "Applications" is 
the first item for the Traditional Layout. The Cupertino Layout 
has no label and simply displays the Ubuntu MATE logo to 
represent the menu.
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How To Choose And Change Panel 
Layouts

 One of the quickest ways to change the look and feel 
of Ubuntu MATE is to select a different panel layout using 
MATE Tweak. Each panel layout is distinctive and provides 
a different desktop workflow. The following descriptions and 
screenshots will let you see what I mean. 
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Familiar (Ubuntu MATE) Layout

When you first install Ubuntu MATE, you'll be using its own 
layout, named Familiar. The Familiar layout, introduced in 
Ubuntu MATE's 18.04 release, has a simple "Menu" button 
in the upper left, a clock in the top right, and a panel with the 
list of open applications at the bottom of the screen. The 
menu bar for each application appears at the top of the 
application's window in a familiar way. (It's "familiar" if you 
are used to the way it's done on Microsoft's application 
windows.) If you prefer to try something else, you can select 
a different panel layout using the "Panel" options in MATE 
Tweak.
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Traditional Layout

The Traditional layout was the default Ubuntu MATE Layout 
prior to release 18.04. It has a classic look of Linux with a 
menu-bar (Applications, Places, System) in the top left, clock
in the top right, and a panel with the list of open applications 
at the bottom of the screen. The menu bar for each running 
application appears at the top of that application's window – 
the traditional way application menus appear on Microsoft's 
application windows.
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Contemporary Layout

The Contemporary layout has the classic look of Ubuntu 
MATE's default Familiar layout, with a "Menu" button in the 
top left, clock in the top right, and a panel with the list of 
open applications at the bottom of the screen. 

A significant difference from the Familiar layout is that, in the
Contemporary layout, each application's menu bar always 
appears in the top panel rather than within the individual 
application's window. This feature was introduced with 
Ubuntu MATE 17.10 and is implemented in the traditional 
way Apple handles menus for its application windows.
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Redmond Layout

The Redmond layout is similar to Microsoft Windows, with a 
single taskbar containing a menu, a list of open applications, 
and a clock at the bottom of the screen. Each application's 
menu bar appears at the top of that application's window in 
the traditional Windows way. The name "Redmond" is a sly 
reference to the US city where Microsoft's headquarters is 
located.

The Redmond layout's "Menu" button provides a list of your 
applications in the bottom left corner. You will find this 
familiar if you've ever used Windows or the Linux Mint 
distribution. 
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Cupertino Layout

The Cupertino layout is similar to Apple's macOS with a 
panel at the top of the screen and a configurable dock at the 
bottom. The dock is used to display the pinned and open 
applications, and to launch applications. The configuration 
for the dock (Plank Preferences) is in the Control Center.

Of course, this layout displays each application's menu bar 
always in the top panel rather than on the application 
windows, in the traditional macOS way. In fact, the name 
"Cupertino" is a reference to the US city where Apple's 
headquarters is located.

You'll notice one distinctive difference between macOS's 
Apple logo icon and the Cupertino layout's Ubuntu MATE 
logo icon in the top left corner. When you click the logo, 
instead of a limited macOS menu that gives you access to 
some basic system tools, Ubuntu MATE gives you access to
the entire collection of applications, utilities, and system tools
installed on your computer. It's a full menu!
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Pantheon Layout

The Pantheon layout is a blend of the Contemporary, 
Cupertino, and Redmond layouts. It has both a "Menu" 
button in the top left and a dock at the bottom of the screen 
that displays pinned and running applications. The 
configuration for the dock (Plank Preferences) is in the 
Control Center. Each application's menu appears at the top 
of that application's window, just as it does in the Redmond 
layout.

Perhaps you like some features of the Windows desktop and
some features of the macOS desktop. If you've ever wished 
that there was an operating system that gave you the best of
both desktops, then maybe the Pantheon layout can grant 
that wish!
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Mutiny Layout

If you have tried other Ubuntu flavors and you like the look of
the Unity desktop, you'll find the Mutiny layout familiar. It 
mimics, as closely as possible, the Unity 7 interface used in 
traditional Ubuntu through 2017. Mutiny has a dock of icons 
on the left of the screen to launch applications, show pinned 
applications, and show running applications. The 
configuration for the dock (Plank Preferences) is in the 
Control Center.

A unique feature of the Mutiny Layout is the menu icon 
above the dock which displays a full-screen pane of 
application icons listed in categories. Each application's 
menu bar appears at the top of that application's window. 

Note: The name "Mutiny" is a reference to controversies that 
arose when Ubuntu changed their standard desktop from 
theTraditional style to Unity. Some Ubuntu users disliked the 
change and switched to other desktops in protest. Similarly, 
some users protested when Ubuntu changed to its current 
Gnome desktop. Ironically, today's Gnome is very similar to the 
original Unity. 

Ubuntu MATE's Mutiny layout looks and behaves much like both 
the original Unity desktop and Ubuntu's latest Gnome desktop. 
Ubuntu MATE avoids the controversy and lets you simply 
choose your preferred layout from a list.
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How To Customize And Save Your Own Panel 
Layout

Of course, since this is Linux it's extremely easy to select 
and configure a desktop layout for the way you use your 
computer. Using the MATE Tweak application, you can 
control which icons display on your desktop, and whether the
windows show some animation or snap into position when 
they open. As you'll see next, you can even change the 
location of the window controls for Close, Minimize and 
Maximize. With any of the out-of-the-box layouts, MATE 
Tweak lets you add or remove a dock and you can even 
name and save your own customized panel layouts to make 
it easy to switch between them. The dock is used to display 
the pinned and open applications, and to launch 
applications. The configuration for the dock (Plank 
Preferences) is in the Control Center.

When you edit the theme, as described in the next section, 
you can do things like change the style and size of the icons 
that appear in the panels. You can right-click on a panel and 
change the properties move the panels to the sides of your 
screen if you like. Many of these theme and panel 
customizations will also be saved along with your custom 
panel layouts.

So, once you've made the changes you want, how do you 
actually save your custom panel layout? 

1. From the Mate Tweak application, choose Panel in 
the left pane.

2. Click the Save As button.
3. Type the name for your layout.
4. Click OK.

Now let's show you how to make some of those changes to 
your layout.
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How To Change The Location Of Window 
Controls

Another quick way to adjust the look of your Ubuntu MATE 
desktop is to change the location of the window controls -- 
the buttons you use to minimize, maximize, and close a 
window. Ubuntu MATE let's you put them on the left like 
macOS or on the right like Windows. You can also include or
exclude a button that displays a menu with more window 
options. Choose the location that you like best or switch 
between them as your mood changes.

To change the location of the window buttons:
1. Open the MATE Tweak application by selecting Menu

► Control Center ► MATE Tweak.
2. Choose the icon labeled Windows in the pane on the 

left side of the MATE Tweak window.
3. Adjust the value for Window control placement. 
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How To Change The Theme

 A desktop theme can include the set of fonts and 
colors used on your desktop, the size and style of icons, the 
size, shape and color of the borders of each window, 
whether there are 3-D or animation effects, and even 
whether the buttons have icons. Do you like the Windows 10
or macOS dark mode themes? Try the Yaru-MATE-dark 
theme! Green isn't your color? Now with release 22.04 LTS 
you can choose color variants of the new Yaru-MATE-light 
and Yaru-MATE-dark themes directly from Appearance. 

Changing your theme is just as easy as changing 
background wallpaper.

1. From the menus choose Menu ► Control Center ► 
Appearance ► Theme.

2. Select the theme you want to use from the list. 
3. Your theme changes immediately. Click Close.

Note: You can use the link on the lower left of the Appearance 
Preferences window to download more themes from the 
Internet. Always make sure you use only trusted sites to obtain 
new themes.
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How To Change The Desktop Background

 Most desktop environments allow you to change the 
background wallpaper by right-clicking on the desktop itself, 
then selecting the appropriate option from the context menu 
that appears. Ubuntu MATE is no exception.

1. Right-click the desktop and choose Change Desktop 
Background. If you prefer, you can use the menus: 
Menu ► Control Center ► Appearance ► 
Background.

2. Select the image you want to use. 
3. If you have a picture on your computer's hard drive 

that you want to use, click the Add button, locate the 
file, and then click Open.

4. Your background changes immediately. Click Close.

Note: You can use the link on the lower left of the Appearance 
Preferences window to download more images from the 
Internet. Always make sure you use only trusted sites to obtain 
new background images.
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How To Adjust Date And Time Settings

 Beginning in release 21.04, Ubuntu MATE returned to
a graphical method of setting what appears in the clock 
indicator. The setting is in the Control Center.

1. Open the Control Center by choosing Menu ► 
Control Center.

2. Open Indicators in the Look and Feel section. This 
opens Ayatana Indicators Settings.

3. Select Date and Time in the left pane of the window 
and the settings for the clock appear in the right pane.

From there you can turn on and off the Year, Month and 
Date, Day of the Week, and Number of Seconds on the 
indicator in the panel. You can also modify some settings for 
the menu that appears when you click on the time in the 
panel.
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How To Modify The Panels

 The bars at the top and bottom edges of Ubuntu 
MATE's Traditional Layout are called Panels. Apple's 
macOS has a menu panel at the top edge of the screen. The
icons that are typically at the bottom of a macOS desktop 
are actually in a dock and not truly in a panel. The single 
panel in Windows is known as the "taskbar" and is typically 
located at the bottom edge of the screen. You can easily 
modify the top and bottom panels of Ubuntu MATE in many 
ways and move them into a different position on the screen. 
You can also have more or fewer than two panels if you 
wish.

1. To begin modifying a panel right-click a blank space 
in the panel and choose Properties from the menu.

2. From within the dialog box, you can edit Orientation 
to choose whether you want the panel at the top, at 
the bottom, or on one of the sides of your screen.
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3. You can increase the size of the panel, and its 
corresponding icons.

4. Choose the Expand checkbox to make the panel go 
completely across the screen. Uncheck it to make it 
behave more like a dock.

5. Use the Show hide buttons setting with Expand 
unchecked to make buttons appear at either end of 
the panel to let you adjust its size.

6. The Autohide setting causes the panel to vanish 
when you move the mouse cursor away from it and 
reappear when your mouse reaches the edge of the 
screen where you placed the panel.

7. The Background tab gives you more options for the 
appearance of the panel, including the ability to make 
it completely transparent, a solid color, or add a 
graphic background image.

8. Click Close to complete your modifications for this 
panel.

9. To add an additional panel, right-click an existing 
panel and choose New Panel.

10.Right-click the new panel you just created and choose
Add to panel to add launchers, monitors, and other 
panel items. (You can do this with existing panels, 
too.)

11.Now start over at step one, above, and edit the 
preferences for your shiny new panel!

- 31 -



How To Adjust Desktop, Panel, And Menu 
Icons

How To Create Application Icons From The 
Menus

 Ubuntu MATE makes it very easy to add icons, also 
referred to as shortcuts or launchers, to your desktop for 
your most frequently used applications. I'll show you how to 
add the word processor icon to your desktop. You can do 
this for any application that appears in the Ubuntu MATE 
menus.

These are the steps to follow:
1. Locate the application in the menu. For the word 

processor application, select Menu ► Office. (If you 
have chosen the Traditional Panel Layout, select 
Applications ► Office.)

2. Now locate, but do not click on the LibreOffice Writer
icon.

3. Right-click on LibreOffice Writer.
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4. From the context menu that appears, select Pin to 
desktop. (If you have chosen the Traditional Panel 
Layout, select Add this launcher to desktop.)

The finished launcher will appear on your desktop as shown 
below. You can move it around and place it anywhere you 
want on the desktop.

Note: When you have selected a panel layout that uses the Brisk
menu, the same context menu lets you pin the icon as a shortcut
icon to the Favourites menu! You find the Favourites menu at 
Menu ► Favourites.

If you are using the Traditional layout's Main menu  you can also 
add a launcher to the panel from the context menu. (Regardless 
of panel layout, you can add a launcher icon to a panel by simply
dragging the icon from the menu and dropping it onto the panel.)
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How To Create System Icons Using MATE Tweak

 If you want to create System icons for such things as 
your "Computer," your "Home" folder, the "Trash" icon, an 
icon to access locations on your "Network," or "Mounted 
Volumes" like USB drives and DVD drives, then Ubuntu 
MATE makes that easy for you, too. You simply use the 
MATE Tweak application, located in Control Center to select 
the icons you want to be displayed. The screenshot below 
shows your "Desktop" options. Ensure that the Show 
Desktop Icons setting is checked to be certain that the 
icons you've selected are visible on your desktop.
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How To Create Launcher Icons In The Menu

 Ubuntu MATE provides you with the ability to edit the 
main menu in the top panel. This can be very helpful if, for 
example, you have created a script (a special text file you 
can create that runs like a program) that you want to launch 
from the menu like any other application. You can even give 
it a custom icon. 

Example: Launching A Script

In this example, you'll see how I added a custom icon to run 
a script that adjusts power and screen brightness on my Dell
XPS-13. Remember, this is just one example of how you can
add entries to the menus. You can add a menu item for a 
script like this one, you can add a menu item for an 
application you've installed, or you can add a menu item to 
open a specific document in a word processor or other 
application. It's up to you. 
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The screenshot above shows my "toggle-awake.sh" script 
open for editing in the Pluma text editor application. Feel free
to copy, modify, and use it if you think it will work for you.

Note 1: If you are writing scripts, the Pluma editor is an excellent
tool to use. As you can see by the colored text in the script 
above, it is designed for this purpose with text highlighting and 
other similar features built-in. 

Note 2: Create a folder named "bin" in your personal home 
folder and Ubuntu MATE recognizes any file you place in that 
folder as a potential executable program or script. To change a 
file's permissions and allow it to run as a program: Right-click on 
the file in the Caja file manager, select Properties ► 
Permissions ► Allow executing file as program.

How To Add The Menu Item

1. In the menus, select Menu ► Control Center ► 
Main Menu. (Or right-click Menu and choose Edit 
Menus.)

2. In the left pane, select the category under which you 
want your menu item to appear. For this example, 
we'll use the "Accessories" category.

3. Click the New Item button to start creating your new 
menu item.

4. To create an icon that launches an application select 
Application as the Type.

5. Click in the field labeled Name and enter the name 
you want to appear in the menu. In the example, we 
named our menu item "Awake".

6. In the Command field, click the Browse button then 
navigate to, and open, the application or script you 
want to run. Alternatively, in the Command field, you 
can type a command as you would enter it in a 
terminal to run the application. This could simply be 
the name of the application, the name of your script, 
or even a long, complex command.
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7. In the Comment field, enter a description that will 
appear when you hover over the icon in the menu.

8. To change the icon for the menu item, click on the 
icon that is displayed by default. It's a button! Browse 
the icons and pixmap folders to select the icon you 
want to use, then click Open. For this example, we 
use a coffee cup icon located here:
/usr/share/icons/hicolor/48/apps/
caffeine.png

9. Click the OK button to create your menu item. It now 
appears in the list of menu items in the category you 
chose. It's at the bottom of the list. You can change its
position in the menu by selecting your new menu item
and using the Move Up and Move Down buttons.

10.Close the editor to begin using your new menu entry.
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How To Manage Your Monitor's Settings

How To Change The Display Resolution

 To accommodate your personal preference, most 
computer monitors will support multiple resolution settings. 
By selecting a supported resolution higher or lower than the 
default you can easlily make the text and images larger or 
smaller on the screen. 

You change monitor preferences by selecting Menu ► 
Control Center ► Displays in the menus.

1. Click the rectangle that represents your monitor then 
on the Resolution setting to display the list of 
resolutions that the monitor is capable of displaying. 
Select a resolution from the list that you would like to 
try.

2. Click the Apply button to activate the new 
configuration temporarily. If you don't confirm the 
settings within 30 seconds, for example, if they aren't 
what you expected or the settings don't work properly,
the configuration will automatically revert to the 
previous settings. 
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3. Click on Keep This Configuration to confirm your 
changes. If you don't click the button before the 
timeout, your old display settings will be re-applied.

How To Connect Multiple Displays

 Ubuntu MATE makes connecting multiple monitors 
and changing the resolution quite easy. You change the 
monitor preferences by selecting Menu ► Control Center 
► Displays in the menus.

1. When you connect a second monitor, it will likely 
connect automatically. If it doesn't, simply click on the 
black rectangle that represents the second monitor 
and choose the On setting. When the display is 
switched to "On" the rectangle will be in color.

2. Select the resolution settings you prefer. The list 
includes all of the resolutions that the monitor is 
capable of displaying. In this example, an HDMI cable
is used to connect a 1080P or 4K television as a 
monitor.

- 39 -



3. To apply the settings, click the Apply button.

4. The new configuration is set temporarily. If you don't 
confirm the settings, for example, if the settings don't 
work properly, after a 30 second delay the 
configuration will automatically revert to the previous 
settings. 

5. Click on Keep This Configuration to confirm your 
changes. If you don't click the button, your old display 
settings will be re-applied.
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How To Scale High-Resolution Monitors

 Linux support for high-resolution computer displays 
(HiDPI, UHD, or 4K displays) has been largely perfected 
over the past few years. Beginning with the 18.04 release, 
the Ubuntu MATE team has included a utility that 
automatically detects your 4K display and sets the 
appropriate screen scaling for you. Without scaling, you may
find that 4K displays, like screens on such modern laptops 
as the Dell XPS 13, or external 4K monitors have tiny icons 
and fonts that make them difficult to see and to use. With 
HiDPI support, Ubuntu MATE lets you take advantage of the 
full resolution of your beautiful high-resolution display and 
still have everything readable.

Of course, Ubuntu MATE allows you to make the decision as
to whether to use HiDPI scaling or not. Here is how to make 
changes to the HiDPI settings.

1. Before we begin modifying your screen settings, use 
the instructions in the previous section to ensure that 
your display is set to the highest resolution available. 
If supported, this will be the HiDPI setting for your 
high-resolution display. For my Dell XPS 13, the 
HiDPI setting is 3200 x 1800 pixels.
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2. The Scaling setting on the Monitor Settings window 
normally defaults to "auto-detect" which lets Ubuntu 
MATE automatically detect and set HiDPI window 
scaling when it detects a high-resolution monitor. The 
"100%" setting is equivalent to "Regular" in the 
Ubuntu Tweak application while "200%" corresponds 
to "HiDPI".

3. To adjust scaling settings using MATE Tweak, open 
the application by selecting Menu ► Control Center 
► MATE Tweak.

4. Choose the Windows icon in the pane on the left side
of the MATE Tweak window.

5. In the HiDPI section, adjust the setting labeled Select
a window scaling factor. Choose Auto-detect to 
have Ubuntu MATE automatically detect and set 
HiDPI window scaling when it detects a high-
resolution monitor. Choose Regular if you never want
scaling applied. Choose HiDPI if you always want 
scaling applied.

6. Your new HiDPI settings will take effect immediately. 
No need to log out!
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How To Manage Power Settings

Strategies For Improving Battery Life

 Today you can install Ubuntu MATE on almost any 
computer hardware -- macOS, Windows PC, or Chromebook
-- but you will want to be sure that components such as WiFi 
and graphics cards are supported by Linux. With a computer
like one from designed-for-Linux lines such as System76, 
Entroware, OpenSourcePC, or Dell XPS Developer Edition, 
you can be sure you'll have the "just works" experience with 
whatever version of Linux you choose to install. But whether 
you choose a computer with Linux pre-installed, or you 
install it on hardware you already own, out-of-the-box laptop 
battery life can sometimes be disappointing. Here are some 
things you can do to improve your laptop's longevity when 
you don't have a connection to AC power.
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1. Adjust Power Management Settings

The Power Management Settings, found in the Control 
Panel, allows you to control when the computer sleeps 
(suspends) or shuts down, and how the display behaves. 
Focus on the On Battery Power settings. To minimize 
battery consumption, use the "Suspend" setting when 
closing the lid and when the computer is idle. 

In addition to using the suspend and shutdown settings, 
reducing the backlight brightness and dimming the screen 
while idle can reduce the battery drain while operating on 
battery power. Using a dark theme and wallpaper can help 
reduce the backlight's brightness as well. 
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2. Adjust Screen Brightness

A laptop's biggest battery use is typically in powering the 
LCD screen. The brighter the screen, the more power is 
consumed. On some models, reducing backlight brightness 
from 100% to about 50% or even 30% provides enough 
illumination to see the screen comfortably except when 
outdoors, and dramatically improves battery life. That 
adjustment is usually controlled by hardware keys on your 
keyboard. If you can find a brightness setting that allows you
to easily read the screen, but no brighter, then you'll extend 
your on-battery time for sure. You'll find the software-based 
brightness adjustment on the On AC Power tab. Its setting 
applies to both when you are on AC (mains) power and 
when you are on battery. However, if you also choose 
Reduce backlight brightness on the On Battery Power 
tab, then when you are using battery power, your display is 
actually adjusted to 50% of the display brightness value you 
choose here.
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3. Turn Off What You Don't Use

Don't use a Bluetooth mouse, keyboard or headphones? 
Turn off your Bluetooth adapter by clicking on the Bluetooth
icon in the top panel and selecting Turn Bluetooth Off. The 
computer uses power when searching for Bluetooth devices.
Turn off similar settings for other devices or services (like 
WiFi) that you never or rarely use.
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4. Use TLP

TLP is an advanced power management utility for Linux that 
can improve your battery life tremendously. TLP optimizes 
power settings automatically on startup and every time you 
change the power source. The Ubuntu MATE 16.04 release 
came with the TLP command-line utility pre-installed and 
pre-configured. If you are using a later release of Ubuntu 
MATE that doesn't install it by default, look in the Software 
Center for TLP. It'll likely be there, ready to install. The 
screenshot shows the default configuration of TLP on my 
Dell XPS 13.
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5. Get A New Battery

Although today's battery technology is vastly superior to that 
of just a few years ago, batteries have a finite lifetime. They 
don't develop a "memory" when you "top up" their charge 
like they used to, but they do have a limited number of full 
charge cycles they can handle before they expire. If your 
laptop's battery will no longer hold a charge, it's likely time to
replace it. Hopefully, your model allows you to do that. If not,
you may be tethered to AC power until you can replace your 
computer.

Note as well that some old or over-heated lithium-ion 
batteries will swell up, possibly deforming your keyboard or 
more disastrously causing an explosion or fire! If you see 
signs of your battery swelling, it is critical to immediate 
replace and responsibly dispose of it. 

Ubuntu MATE comes pre-installed with a utility that lets you 
keep tabs on how your power is being used. You can find it 
at Menu ► System Tools ► Power Statistics.
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How To Optimize The Screensaver

 The concept of a screensaver was introduced when 
the cathode ray tube (CRT) was the only type of computer 
monitor available. In today's world, this software that 
originally prevented a permanent image from burning into a 
CRT's phosphor screen is used mainly to provide an 
interesting animated image on the monitor when you step 
away. Although the power management settings can lock 
your screen, so too can the screensaver. It's your choice 
whether to use the screensaver or the power management 
settings to manage screen locking. If you don't care for an 
animated screensaver, you can choose to disable it 
altogether.

- 49 -



How To Adjust The Screensaver Settings

The screensaver settings can be found at Menu ► Control 
Center ► Screensaver. 

1. Choose from the available default images or choose 
to use the images you saved in your pictures folder as
the screensaver. You can also choose a simple blank 
screen or random images. 

2. The time setting that appears below the image 
preview allows you to control the amount of time it 
takes after your mouse and keyboard have been idle 
before the screensaver activates. 

3. Uncheck Activate screensaver when computer is 
idle to completely disable the screensaver. 

If you choose to use the screensaver, a check mark in the 
setting Lock screen when screensaver is active ensures 
that you must enter your password to dismiss the 
screensaver. Unchecking the box means that the 
screensaver will stop without asking for your password as 
soon as you move the mouse or type on the keyboard.
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How To Add Software To 
Ubuntu MATE

Installing Trusted Linux Applications

 Almost every software package that is available and 
tested for Ubuntu MATE is available in the online software 
repositories (think: software catalog). The concept of 
software repositories is likely not all that familiar to long-time 
users switching from Windows since classic Windows users 
normally had to go to a brick-and-mortar store or to the 
software publisher's site online to purchase new software for 
the Microsoft operating system. For macOS users, however, 
the concept of the Apple App Store is similar in concept to 
the software repositories. Both contain trusted applications 
verified to run on their respective operating systems. Unlike 
most software in the App Store, the vast majority of Linux 
applications are neither proprietary nor expensive.

The software repositories for Ubuntu MATE are managed, 
maintained and updated by the distribution's maintainers and
are variably referred to as "the software catalog," "the 
software library," "the software center," "software sources," 
or simply "software repositories". These repositories contain 
almost ALL of the full-featured, free and open source 
software that has been tested for installation on Ubuntu 
MATE and other Ubuntu derivatives. And they won't put 
spyware and viruses on your computer!

To install software on Ubuntu MATE, you normally use the 
Software Boutique. You can also use the Software Center or
the Synaptic package manager. When a Linux user says 
"package" think "software package". 

Software centers and package managers are examples of 
applications that are used to browse and retrieve software 
packages from software repositories. 
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Ubuntu MATE conveniently gives you the option to install 
one when your search in the Software Boutique returns no 
results for an application that does what you want.

Trusted Sources

 The Ubuntu software repositories include thousands 
of applications in hundreds of categories, suitable for just 
about any professional or recreational pursuit, and most are 
free of charge. When you use Ubuntu MATE, those 
applications as well as security updates, driver updates, 
application updates, software upgrades, and operating 
system upgrades are all available from trusted sources so 
you won't need to search the Internet for software. No more 
risking malware, junkware, or ransomware as a result of 
downloading from the wrong site! Ubuntu's software catalog 
is the ultimate in a trusted source!

There are several ways to obtain software from the software 
catalog. Ubuntu MATE's own Software Boutique is a 
carefully curated selection of the best-in-class applications 
from the Ubuntu repositories, chosen because they integrate
well, complement Ubuntu MATE, and enable you to 
personalize your computing experience. When you first 
install Ubuntu MATE, the Software Boutique is the main 
graphical application you will use to install software. 

Thousands of applications not available in the Software 
Boutique are available to explore in the full Ubuntu software 
catalog and from the the unique Snap Store, located at 
https://snapcraft.io/store. You have full access to the entire 
Ubuntu library of software at any time using the command 
line or by enabling one or more of the software center 
applications from within the Software Boutique. 

Note: Installing applications from the repositories and from the 
Snap Store using the command line is discussed in more detail 
in the section on the MATE Terminal application, below.
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Software Boutique

 The Software Boutique's curated selection of the 
most popular and often used applications lets you:

 Select from the list of Ubuntu MATE's recommended 
software, tested for the distribution.

 Use simple tools to manage software packages 
installed on your system.

 Install a software center or package manager with 
even more powerful ways to obtain additional software
for your computer.
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How To Install Applications Using The Software 
Boutique

1. To launch the Software Boutique from the menus, 
choose Menu ► Administration ► Software 
Boutique.

2. One easy way to discover applications is to click one 
of the icons across the top of the window that 
represent categories and scroll through the list and 
read the description for more information. 

3. If you know the name of the package you want to 
install, click the magnifying glass (search) icon at the 
top right to begin a search. 

4. When you find an application you want to install, click 
the Install button. Your application will not be 
installed immediately. It will be added to the bulk 
queue.

5. To view the list of all applications you added to the 
queue, click the icon to the left of the search icon, the 
bulk queue icon.
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6. Click the Apply Changes button to begin installing 
the applications in the list. 

7. You will be notified when the installations have 
completed and then you will be able to close the 
Software Boutique.
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How To Install Other Software Center 
Applications

 If you don't find what you're looking for in the 
Software Boutique, you can easily install one of the available
Software Centers to explore the complete Ubuntu software 
catalog. From within the Software Boutique, choose the 
"More Software" category using the icon at the top of the 
Software Boutique's main window.

The selection labeled simply "Software" installs a simple 
graphical application that lets you browse, install and update 
additional software applications and system extensions from 
the Ubuntu software repositories.

The "Synaptic Package Manager" is a more powerful 
graphical package management application that lets you 
install software onto your computer and manage the 
software that is already installed. 
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It allows you to search, install, upgrade, and remove 
packages using the software repositories. 

Synaptic also lets you add more software sources, modify 
repository settings, view change logs, and even lock a 
package to a specific version.

Ubuntu MATE always has security in mind. Regardless of 
how you choose to install software, to ensure your security, 
you are always asked for your password before anything can
be installed. 

These are some of the more popular software selections 
beyond those pre-installed with Ubuntu MATE: 

 Barrier keyboard and mouse sharing application
 Dropbox for file sharing
 Gimp advanced image editor
 Microsoft's Teams for Linux
 Minetest minecraft-inspired game
 Skype for Linux
 The Steam gaming platform
 Slack collaboration tool for teams
 Spotify for music
 Telegram messaging app
 VirtualBox virtual machine
 Visual Studio Code code editor

There is much more software available in the Ubuntu catalog
and in the Snap Store. You can browse by the application's 
name or by function -- what the application does. Because 
the vast majority of the software available in the repositories 
is free, you can try applications and if you don't like them, or 
if they don't do what you expect them to do, you can uninstall
them just as easily.

Note: New to the world of Open Source software? Wondering 
how to know which Linux application to choose? The 
AlternativeTo website https://alternativeto.net lets you find Linux 
applications that perform the same or similar functions as apps 
or software you currently use on Windows, macOS, Chrome OS,
iPhone, iPad, Android, Web Apps, Online, and more.
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How To Use The Applications

Ubuntu MATE Welcome

 Developed by the Ubuntu MATE team, the Ubuntu 
MATE Welcome application is a utility that helps you to get 
comfortable with your new operating system. The first 
application you will see when you have installed Ubuntu 
MATE, Welcome guides you in a step-by-step fashion 
through post-install configuration such as installing drivers 
and adding language support. 

Welcome introduces new users to the operating system, 
highlights key features of Ubuntu MATE, provides quick 
guidelines on getting started and displays your computer's 
system specifications. 
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Welcome also introduces users to the Ubuntu MATE 
Community with links to the community forums, social 
networks, the Ubuntu MATE store with branded products for 
sale, and details on donating to the project.

In addition, welcome includes access to the Software 
Boutique. It is exactly the same Software Boutique available 
from the menus and is provided here for convenience.

Getting Started: Updates & Extras

One of the first things you will want to do after you install 
Ubuntu MATE for the first time, or after upgrading to a new 
release, is to click on the Getting Started button in the 
Welcome application and choose Updates & Extras. This 
walks you through some common post-installation 
configuration tasks like checking for updates, adding support
for audio and video, and adding Blu-Ray and DVD playback 
support. 
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It's organized in a step-by-step wizard so you don't miss 
anything -- and you can go back at any time to undo what 
you've done, or to find something you skipped. Don't be 
surprised when you are asked for your password. You are 
performing updates and installing software. Ubuntu MATE is 
just keeping you safe.

Clicking the Next button in the upper right of the window 
takes you to the next topic, Drivers.

Getting Started: Drivers

Most drivers for Linux distributions like Ubuntu MATE are 
already provided as part of the Linux kernel. The kernel is 
the foundational part of the operating system that makes 
Linux Linux. While a wide range of hardware is compatible 
with Ubuntu MATE, your computer hardware might include 
some components and peripherals that require proprietary 
drivers to function at their best. 

When you were installing Ubuntu MATE, you were asked if 
you wanted to download and use third-party software. If you 
ticked the checkbox to do that, clicking the Additional 
Drivers button reveals which, if any, proprietary drivers have
already been installed and enabled for you. If you did not 
purchase your computer with Linux pre-installed, you may 
find that clicking Install Firmware Package is required to 
get some devices to work correctly.

The open source drivers for some proprietary devices, the 
ones provided in the kernel, are sometimes reverse-
engineered. What that means is that the manufacturers of 
proprietary devices won't provide the specifications or the 
details of their own drivers to open source developers 
because they want to keep their "technology" secret. (Hence
the term proprietary.) The developers of reverse-engineered 
open source drivers provided in Ubuntu MATE have made 
their best effort and have tested the functionality thoroughly, 
but sometimes there are features that could not be 
reproduced and are not provided in these drivers.
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Sometimes, manufacturers of proprietary devices will 
provide Linux-compatible drivers that they develop 
themselves. Those manufacturers won't let us know how 
their drivers work, so they never make it into the kernel, but 
where these proprietary drivers are available, they 
sometimes perform better than the reverse-engineered 
versions. With Ubuntu MATE, many of the proprietary drivers
that have been made available are provided in the Welcome 
application, or in the Software & Updates application, 
available in the menu at Menu ► Administration ► 
Software & Updates. Usually, Ubuntu MATE automatically 
makes the best selection of open source or proprietary 
drivers for your hardware when it's installed, but you have 
the choice of which driver works best for you.

If you find that Wi-Fi, Bluetooth or other hardware does not 
work, and Welcome's Additional Drivers button did not find 
alternative drivers, you may need to research your device to 
find the appropriate driver. You'll find three methods of 
discovering your computer's specs in the section of this book
entitled "How To Display Your System Information".

If there is nothing available in Additional Drivers to improve
the performance of your hardware device, you may find 
something on the hardware manufacturer's site. You may 
need to install proprietary manufacturer drivers using the 
command line if you choose to use them. If you do, be 
careful to follow the installation instructions diligently. Before 
you install, make a system backup and understand how to 
uninstall just in case the proprietary drivers don't work. DO 
NOT simply search for drivers using drivers.com or other 
third-party sites. When you use third-party sources, there is 
no guarantee that you aren't getting something that will inject
malware or corrupt your system. If you are unsure, or if you 
simply can't figure it out, you are better off asking about it in 
Ubuntu MATE Community forums and looking for someone 
else that has some advice or experience. Or you could just 
settle for the possibly lower performance of the reverse-
engineered driver. 
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Of course, if you happen to be an expert in a device that 
doesn't have drivers in the kernel, the open source 
community would appreciate you sharing your expertise to 
help develop high-performance open source drivers for 
inclusion in the kernel.

Getting Started: Setting Up Printers

Setting up a printer is often as simple as plugging in its USB 
cable, or connecting it and your computer's Wi-Fi to your 
home wireless network. 

To learn more about setting up a printer you can click on 
Read more on printing, in the Printers section at the 
bottom of the Drivers page in the Getting Started window. 
There you can discover Linux-compatible printers that can 
be detected and setup automatically. For even more on 
printing see the "How To Use Ubuntu MATE's Document 
Management Applications" section, later in this book. 
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Getting Started: Additional Utilities

At the bottom of the Drivers page of Getting Started, in the 
Printers section, click on the Software Utilities for 
Peripherals section. You will find a selection of helpful 
applications that you can install from the Ubuntu 
repositories. Click the Install button below the description of 
the software utility you want to download and install.

One example that I have used is Solaar, which is a very 
useful utility for pairing and unpairing Logitech Unifying 
Receivers with Logitech peripherals like mice and 
keyboards.
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Getting Started: System Specifications

When you move to a new operating system, whether it's 
Windows, ChromeOS, macOS, or Ubuntu MATE that's new 
to you, it's sometimes difficult to find what you are looking for
-- at first. Take finding a list of your system hardware for 
example. In classic Windows, if you wanted a graphical 
display of the specs for your computer, you right-clicked on 
the My Computer desktop icon and selected Properties. 
With Windows 10, you click the Windows logo in the 
taskbar, then select Settings ► System ► About. Neither 
is likely to be very intuitive if you have only ever used a Mac.

On Apple's macOS, you select About This Mac from the 
Apple logo menu to get a dialog box with selections to 
display at least some of your computer's specifications. 

Linux, too, has graphical tools to display information about 
your computer's hardware. 
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Ubuntu MATE provides system specifications in the 
Welcome application. From the menu, select Menu ► 
Welcome ► Getting Started ► System Specifications.

This graphical method presents a nice browseable list of 
information, but with a terminal and a few commands, you 
can really dig under the hood of your Ubuntu MATE 
computer's hardware. See the section on the "MATE 
Terminal" later in this book for details on how to use the 
command line to reveal additional system information stored 
in text files on your hard drive.
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The Ubuntu MATE Guide

 The Ubuntu MATE Guide, found in the Ubuntu MATE 
menus at Menu ► Accessories ► Ubuntu MATE Guide, is
for users needing a little extra help while learning to use 
Ubuntu MATE.

Note: The Ubuntu MATE Guide was written by the author of this 
book, so don't be surprised that the content looks familiar!

The Ubuntu MATE Guide doesn't attempt to exhaustively 
cover every feature of the operating system. It has been 
created for you and other computer users like you who want 
an always-available reference, right there in the operating 
system, to help you to learn about Ubuntu MATE. 
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It can help you to build your confidence and competence in 
using Ubuntu MATE and its applications while you use them 
to get things done.

How To Search For Help In The Guide

Scrolling through the guide and jumping from topic to topic is
fine if you want to read the Ubuntu MATE Guide like a 
manual. If you are looking for help on a particular topic, 
clicking the magnifying glass icon in the upper right corner of
the help window opens a search tool. Type what you want to
search for into the search box and press Enter to see a list 
of topics related to your search.
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Accessibility Software

 Accessibility, also referenced as "Assistive 
Technology" or "Universal Access," is a key priority for 
Ubuntu MATE. When computer access is shared within a 
household or business and where individual needs differ, 
Ubuntu MATE is an excellent solution.

Preference settings for basic accessibility features are found 
in the Control Center at Menu ► Control Center ► 
Assistive Technology. From there you can check the box 
to enable assistive applications, change which visual and 
mobility applications are used by default, and even change 
whether they are started automatically when your computer 
starts up. From there you can also modify your keyboard 
(sticky keys, slow keys, bounce keys) and mouse (locate 
pointer, acceleration, sensitivity, drag & drop, double-click 
timeout) accessibility settings. You can even enable an on-
screen keyboard if you need it.
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Ubuntu MATE has many keyboard shortcuts that, by 
pressing a combination of keys, help you do things that 
normally require a mouse, trackpad, or another input device 
that might also require sight or muscular range of motion not 
possible for some computer users who require accessibility. 

For some of these keyboard shortcuts, Ubuntu MATE makes
use of a special meta key, the "Super" key, available on 
most computer keyboards. The Super key can be used to 
activate the menus/launchers and many keyboard shortcuts 
that include the Super key. Appendix A lists some common 
ones.

Note: On computer keyboards designed for use with the 
Windows operating system, the Super key is labeled with the 
"Windows" logo. On keyboards designed for use with Apple's 
operating system, the Super key is identified as the "Command" 
key. On computers designed for Linux, the Super key may be 
labeled with the Tux penguin logo (the Linux mascot), the 
Ubuntu logo, or perhaps even a blank square. 
When you order a computer pre-installed with Linux from the 
manufacturer Dell, you will need to follow Dell's instructions on 
how to enable the Super key. Details are available from Dell's 
support website in a knowledge base article entitled, "How to 
enable the Ubuntu super key on Dell OEM Ubuntu installations."

Enabling Accessibility At Startup

When Ubuntu MATE is first installed as your computer's 
operating system, it is pre-configured so that both Orca, the 
screen reader, and Onboard, the on-screen keyboard, are 
already installed and ready to use. All you need to do to use 
them is press the keyboard shortcut detailed in each section 
below to turn the feature on. You use the same shortcut to 
turn each application off again.

If you want to use these features at the login screen, before 
Ubuntu MATE even starts, the accessibility icon in the upper 
right of the screen lets you toggle on and off Orca and 
Onboard. You can also use Orca's keyboard shortcut <Alt> 
+ <Super> + S to enable the screen reader to assist with the
login process.
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Orca Screen Reader

 The Orca screen reader is a free, open source, 
flexible, and extensible screen reader that provides you with 
access to the graphical desktop via user-customizable 
combinations of speech and/or braille. It is pre-installed in 
Ubuntu MATE for blind and low vision users. At the login 
screen, and after Ubuntu MATE starts, you toggle the screen
reader off and on by pressing <Alt> + <Super> + S. 

With some other Linux distributions, getting Orca to work can
be tricky. With Ubuntu MATE all the setup is done for you. It 
also works nicely with pretty much all of the pre-installed 
software, including the LibreOffice office suite and the 
Firefox web browser. 

For complete information about using and configuring the 
Orca screen reader, refer to the website 
https://help.gnome.org/users/orca/stable/. 

The Orca documentation on the website occasionally refers 
to the "Orca Modifier" key. The key that Orca uses by default
as the "Orca Modifier" depends on whether you are using 
Orca's "Laptop" keyboard layout or its "Desktop" keyboard 
layout

Orca Modifier: 
If you are using Orca's "Laptop" layout, the default Orca Modifier 
will be <CapsLock>.

If you are using Orca's "Desktop" layout, for the Orca Modifier 
you can use either the normal <Insert> key or the <KeyPad> + 
<Insert>. On most US keyboards, <KeyPad> + <Insert> is the 
same key as the 0 (zero) on the numeric keypad.

Orca Help: 
- To view Orca's documentation, press <F1>.
- To hear a list of Orca's shortcuts, press <F2>.
- To hear a list of Orca's shortcuts for the current application, 
press <F3>.

- 70 -



You can use the "Orca Modifier" key to get to Orca's help. 
Press <Orca Modifier> + H to enter "learn mode".

To learn more about how to use Orca to read documents 
and websites, see the web page: 
https://help.gnome.org/users/orca/stable/#reading.

You may find that the screen reader speaks too slowly or too
quickly for you. You can adjust the rate at which Orca 
speaks, and make other adjustments as well, in Orca 
Preferences. To get to the Orca Preferences screens, 
press <Orca Modifier> + <Spacebar>. If you find yourself 
needing to adjust the speed frequently, you might want to 
bind (map) the "increase the rate" and "decrease the rate" 
commands to specific keys. That way you can more easily 
make these adjustments. To review (and setup) the 
keyboard shortcuts and commands that Orca uses, you will 
want to refer to the documentation on key bindings on this 
web page: 
https://help.gnome.org/users/orca/stable/howto_key_binding
s.html.en. 

This is just a small sampling of the documentation that is 
available to you on the Orca site. Browse around. Discover 
what this powerful tool can do! 
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How To Use Onboard, The On-Screen Keyboard

 Onboard is the name of Ubuntu MATE's on-screen 
keyboard. Onboard is pre-installed in Ubuntu MATE and is 
available at the press of a few keys for anyone requiring the 
use of an on-screen keyboard in place of a traditional 
hardware keyboard. In addition to supporting mobility-
impaired users, Onboard provides support for tablet and 
touch-screen computers. To turn Onboard off or on again 
from the hardware keyboard, press <Alt> + <Super> + K. 

You can also enable Onboard so that it is available on-
screen right at startup: 

1. Open the Assistive Technologies Preference tool, 
found at Menu ► Control Center ► Assistive 
Technology.

2. Check the box labeled Enable assistive 
technologies.

3. Click the Preferred Applications button. 
4. Select the Accessibility tab.
5. Check the box labeled Run at start and click Close.

Note: More settings and preferences for Onboard are listed in 
the Control Panel in the Personal section as "Onboard Settings". 
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How To Use The Screen Magnifier

 If you are a low vision user and you require screen 
magnification, Magnus, found in the Ubuntu MATE menus at
Menu ► Universal Access ► Magnus, is a very simple 
desktop magnifier you can use. It shows the area around the
mouse pointer in a separate window. You can select the 
level of magnification that works for you between two, three, 
four, and five times. The screen magnifier is also useful for 
accurate graphical design or detail work. To turn on or off the
screen magnifier, press <Alt> + <Super> + M. 
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How To Enable Mobility Preferences

 The Control Panel provides preferences for Mouse 
and Keyboard that each offer settings that will be of interest 
to users with mobility impairments.

 Mouse Preferences provide the ability to adjust the 
Pointer Speed sliders until the pointer motion is comfortable 
for you. A tab is provided for mouse and touchpad with 
sliders for each device. You can set different pointer speed 
for each type of device. For example, you can have one 
speed setting for a laptop touchpad and another for a 
mouse. Sometimes the most comfortable settings for one 
type of device are not the best for another. Note that the 
Touchpad tab only appears if your system has a touchpad.
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 Keyboard Preferences provides several tabs that 
have settings allowing you to adjust the following:

 Keyboard navigation -- Use applications and the 
desktop without a mouse.

 Turn on bounce keys -- Ignore quickly-repeated key 
presses of the same key.

 Turn on slow keys -- Have a delay between a key 
being pressed and that letter appearing on the screen.

 Turn on sticky keys -- Type keyboard shortcuts one 
key at a time rather than having to hold down all of the
keys at once.
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How To Use The MATE Desktop's 
Applications
In Ubuntu MATE, the software you might expect to find on 
any computer is provided by the MATE desktop. This section
describes the most commonly used applications.

File Browser (Caja)

 The Caja application, found in the Ubuntu MATE 
menus at Menu ► System Tools ► Caja, lets you organize
and manage files and folders, both on your computer and on
a home network. In Ubuntu MATE many things are files, 
such as word processor documents, spreadsheets, photos, 
movies, and music. Caja lets you manage them all.

- 76 -



Using the file manager you can do the following:
 Create documents and folders.
 Display files and folders.
 Search for and manage your files.
 Run scripts and launch applications.
 Open special locations on your computer.
 Write data to a CD or DVD.
 Install and remove fonts.

Like file managers in other operating systems (Apple calls 
their file manager "the finder") Caja lets you organize your 
files into folders. Folders can contain files and even other 
folders. Some people find that organizing files into folders 
can help them locate their files more easily.

Ubuntu MATE allows more than one user to login to the 
same computer. Each user has a personal Home folder that 
is labeled with the username chosen during setup. In the 
illustration, the username and the name of the personal 
Home folder is lebushey. The folder that is actually labeled 
"home" contains the personal Home folders for each user 
setup on your computer. Normally, there is just one user 
(you) and so the home folder contains only your own 
personal Home folder.

By default, your personal Home folder contains several 
folders (sub-folders) and any files that you create. Viewed 
from the Caja file manager, Desktop is just another folder in 
your personal Home folder that can, itself, contain folders 
and files.

When viewing the desktop showing your background 
wallpaper, Desktop can display special icons that allow easy 
access to your personal Home folder, Trash, and removable 
media such as CDs, USB flash drives, and (if your computer 
is old enough) floppy disks. See how to enable these special
desktop icons in the section of this book entitled "How To 
Create System Icons Using MATE Tweak".

The Caja file manager is always running while you are using 
the MATE desktop environment. 
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To open a new Caja window, double-click on an icon on the 
desktop such as Home or Computer, or choose the 
application from the menu at Menu ► System Tools ► 
Caja. 

With the Caja window open, you can also open a second 
pane within the window by pressing the <F3> key on your 
keyboard. Press the <F3> key again to close the second 
pane.

In addition to the folder contents, the browser window 
displays a toolbar with common actions and locations, a 
location bar that shows the current location in the hierarchy 
of folders, and a sidebar that can hold different kinds of 
information.

The file manager window is a file browser of sorts. Double-
clicking the icon for a file opens the file in the Caja software 
application that lets you view and/or edit the document. 

Opening a folder by double-clicking on its icon updates the 
current file manager window to show the contents of the 
opened folder. You can also open a folder by right-clicking 
on that folder, then choosing between Open (this is the 
same as simply double-clicking the folder), Open in a New 
Tab, or Open in a New Window. 

Note: For more information about how you can use Caja and the
various preferences that you can set, see the Caja manual 
("Desktop User Guide") by pressing <F1> while Caja is open.
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Text Editor (Pluma)

 The Pluma text editor, found in the Ubuntu MATE 
menus at Menu ► Accessories ► Pluma Text Editor, 
enables you to create and edit text files. The aim of Pluma is
to be a simple and easy to use text editor. You can enable 
more powerful features with different plug-ins, allowing a 
variety of tasks related to text-editing.

The Pluma window contains the following elements:

Menubar

The menus on the menubar contain all of the commands you
need to work with files in Pluma. Note, if you have chosen a 
layout that uses the Global Menu, the menubar items will be 
displayed in the Global Menu rather than within the Pluma 
window. 
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Toolbar

The toolbar contains icon buttons that represent a subset of 
the commands that you can access from the menubar.

Display area

The display area displays the text of the file you are editing.

Status Bar

The status bar is at the bottom of the window and displays 
information about how you are using Pluma. The status bar 
display includes the following information:

Cursor position is the line number and column number 
where the cursor is located.

Edit mode is changed using the <Insert> key on your 
keyboard. If the editor is in insert mode, the status bar 
contains the text "INS". If the editor is in overwrite mode, the 
status bar contains the text "OVR". 

Side Pane

By default, the side pane is not shown. To show it, choose 
View ► Side Pane.

The side pane displays a list of open documents and other 
information depending on which plugins are enabled.

Bottom Pane

The bottom pane is used by programming tools such as the 
Python Console plugin to display output.

By default, the bottom pane is not shown. To show it, choose
View ► Bottom Pane.

When you right-click in the Pluma window, a popup menu 
appears containing the most common text editing 
commands.
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Like other MATE applications, actions in Pluma can be 
performed with the menu, with the toolbar, or with keyboard 
shortcuts. See Appendix A for a list of common keyboard 
shortcuts.

How To Create A New Document

To create a new document, choose File ► New. Pluma 
displays a new blank document in the display area.

How To Open A File

If you have the Caja file manager open and you can see 
your file, simply double-click it, otherwise, to open a file from 
within Pluma, choose File ► Open to display the "Open 
File" dialog. Navigate to the folder that contains your file, 
then select the file that you want to open and click Open. 
The file is displayed in the Pluma window. You can open 
multiple files in Pluma. The application adds a tab for each 
open file to the window above the display area. 

How To Save A File

To save changes to a file you have opened and/or already 
saved, choose File ► Save.

To save a new file or to save an existing file under a new 
filename, choose File ► Save As. Enter a name for your file
and click Save.

To save all of the files that are currently open in Pluma, 
choose Documents ► Save All.
To close all of the files that are currently open in Pluma, 
choose Documents ► Close All. If you have any open files 
with unsaved edits, you will be prompted to save them 
before that file is closed.

Note: For help topics on this application, see the Pluma manual 
by pressing <F1> while Pluma is open.
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MATE Calculator

 The Calculator application can be found in the Ubuntu
MATE menus at Menu ► Accessories ► MATE 
Calculator. It is a calculator with ordinary notation/reverse 
polish notation (RPN), a formula entry mode, different 
number bases (DEC, HEX, OCT, BIN) and different units of 
angular measure (DEG, RAD, GRAD). It supports quad-
precision floating point and 112-bit binary arithmetic. MATE 
Calculator has four modes: Basic, Advanced, Financial and 
Programming. The Advanced mode is shown, below.

Note: For help topics on this application, see the Calculator 
manual by pressing <F1> while MATE Calculator is open. Topics
include user interface, equations, number formats, conversions 
and financial calculations.
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Archive Manager (Engrampa)

 You can use the Engrampa Archive Manager 
application, found in the Ubuntu MATE menus at Menu ► 
Accessories ► Engrampa Archive Manager, to create, 
view, modify, or unpack an archive. An archive is a file that 
acts as a container for other files. Sometimes referred to 
generically as "zipped files" or "compressed files," an archive
can contain many files, folders, and subfolders, usually in 
compressed form. 

The most common archive format on UNIX and Linux 
systems is the tar archive, compressed with a file name 
ending in "tar.gz" or "tar.bz". The most common archive 
format on Windows systems is an archive created with 
applications that generate archives with a file name ending 
with ".zip". Archive Manager supports all of these formats, 
and if you have the appropriate command-line tools installed,
it will support many more.

The Archive Manager application window includes the 
following elements:

Menubar

The menus on the menubar contain all of the commands you
need to work with files in Archive Manager. Note that if you 
have chosen a layout that uses the Global Menu, the 
menubar items will be displayed in the Global Menu rather 
than within the Archive Manager window. 

Toolbar

The toolbar contains icon buttons that represent a subset of 
the commands that you can access from the menubar.
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How To Use Archive Manager

When you use Archive Manager to work with an archive, all 
your changes are saved immediately. For example, if you 
delete a file from an archive, Archive Manager deletes the 
file as soon as you click OK. This behavior is different to that
of most applications, which save the changes only when you
quit the application or select Save in the menu.

To create a new archive file, you can choose Open from the 
menu, click and drag one or more files or folders from the 
Caja File Browser window into the Archive Manager window,
or right-click one or more files in Caja and selecting 
Compress from the menu.

To expand a compressed file's contents, you start by 
opening the archive by double-clicking it in the File Browser. 
Next, you can choose one or more files in the Archive 
Manager window and either choose Extract from the menu 
or drag them to the desktop or other location where you want
the files to end up. 

If an archive is very large, or you have a slow system, some 
archive actions can take significant time. To abort the current
action, press <Esc>. Alternatively, choose View ► Stop, or 
click Stop in the toolbar. 

Note: For help topics on this application, see the Archive 
Manager manual by pressing <F1> while Archive Manager is 
open.
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Image Viewer (Eye of MATE)

 The Eye of MATE Image Viewer application, found in 
the Ubuntu MATE menus at Menu ► Graphics ► Eye of 
MATE Image Viewer, enables you to view single image 
files, as well as large image collections. 

The Image Viewer can open a wide variety of image file 
formats including animated graphics (ANI), bitmaps (BMP, 
PNG, ICO, PCX, WBMP, XBM, XPM), vector graphics 
(SVG), and other popular formats like JPEG, GIF, TIFF, and 
more. Files can be saved in BMP, ICO, JPEG and PNG 
formats.

The Image Viewer window contains the elements listed in 
the sections below.

Menubar

The menus on the menubar contain all of the commands you
need to work with images in Image Viewer. Note, if you have
chosen a layout that uses the Global Menu, the menubar will
be displayed in the Global Menu rather than in the Image 
Viewer window. 

Toolbar

The toolbar contains icon buttons that represent a subset of 
the commands that you can access from the menubar.

How To Use Image Viewer

Image Viewer has features to help you view your images. 
You can zoom in and out or view the image full-screen. You 
can rotate and flip the image you are viewing.
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The collection view allows you to view and edit large image 
collections. In this view, image operations can be applied to 
all selected images at once.

Image Viewer has special support for digital camera pictures
and displays EXIF metadata recorded with the image. All 
modifications made in JPEG images are lossless. That is, 
saving rotated and flipped JPEG images will not recompress 
the image. Beside this, all available metadata (like EXIF) will 
be preserved and updated accordingly. 

Note: For help topics on this application, see the Image Viewer 
manual by pressing <F1> while Image Viewer is open.
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Document Viewer (Atril) 

 The Atril Document Viewer, found in the Ubuntu 
MATE menus at Menu ► Office ► Atril Document Viewer,
allows you to view documents in formats like Portable 
Document Format (PDF) files, PostScript files, and e-book 
(EPUB) files. 

You can open the Atril Document Viewer from the menus, or 
more simply by double-clicking on the file you want to open 
in the Caja file manager. To zoom in and out, you can use 
the keyboard shortcuts <Ctrl> + + (the plus key) and <Ctrl> 
+ - (the minus key). You can also hold the <Ctrl> key while 
scrolling the mouse wheel, or you can use the on-screen 
button to select from some preset zoom levels including "Fit 
Page Width" and "Best Fit" among others.

Navigate through a document by clicking the Next and 
Previous buttons or by using the Go menu. Jump to a 
particular page by entering the page number in the text box 
on the toolbar, then press the <Enter> key on the keyboard.

Menubar

The menus on the menubar contain all of the commands you
need to work with documents in Atril. Note, if you have 
chosen a layout that uses the Global Menu, the menubar 
items will be displayed in the Global Menu rather than within 
Atril's window. 

Toolbar

The toolbar contains icon buttons that let you navigate the 
document by page and change the zoom factor.

Left Navigation Pane (Side Pane)

To view bookmarks or pages, choose View ► Side Pane or 
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toggle the Side Pane on or off by pressing <F9> on your 
keyboard. Depending on the type of file you are opening, the
left pane of the Atril window may show an index, bookmarks,
an outline, or annotations. Clicking the header lets you 
switch between them. Navigate the document's pages, by 
scrolling with your mouse, or by using the side pane to jump 
to a topic.

How To Read Password-Protected Documents

The author of a PDF document can use the following 
password levels to protect a document:

 User password that allows others only to read the 
document.

 Master password that allows others to perform 
additional actions, such as print the document.

When you try to open a password-protected document, Atril 
Document Viewer prompts you for a password. Type either 
the user password or the master password in the Enter 
document password text box, then click Open Document.

Note: For help topics on this application, see the Atril Document 
Viewer manual by pressing <F1> while Document Viewer is 
open. Topics include printing, copying, and working with 
password-protected documents.
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MATE Disk Usage Analyzer (Baobab)

 The MATE Disk Usage Analyzer, found at Menu ► 
System Tools ► MATE Disk Usage Analyzer, is a 
graphical tool for analyzing how your storage media is being 
used. It can scan the file system on a disk or in a specific 
folder. It provides a graphical treemap window for each 
selected disk or folder.

Menubar

The menus on the menubar contain all of the commands you
need to work with the disks and file system in Disk Usage 
Analyzer. Note, if you have chosen a layout that uses the 
Global Menu, the menubar items will be displayed in the 
Global Menu rather than within the Analyzer's window. 

Toolbar

The toolbar contains icon buttons that represent a subset of 
the commands that you can access from the menubar.

Note: For help topics on this application, see the MATE Disk 
Usage Analyzer manual by pressing <F1> while Disk Usage 
Analyzer is open.
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MATE System Monitor

 The MATE System Monitor, found in the Ubuntu 
MATE menus at Menu ► System Tools ► MATE System 
Monitor, enables you to display basic system information 
and monitor system processes, usage of system resources, 
and file system usage. You can also use MATE System 
Monitor to modify the behavior of your system.

The System tab shows information about the computer's 
hardware and software, as shown above. The Processes 
tab, shown below, shows information about active processes
(applications, utilities, etc.) and how they relate to each 
other. You can stop, end, or kill a process or otherwise 
control active processes.
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The Resources tab displays current CPU, memory, and 
network usage. The File Systems tab lists all mounted file 
systems and basic information about each.

Note: For help topics on this application, see the MATE System 
Monitor manual by pressing <F1> while MATE System Monitor is
open.
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MATE Terminal

 MATE Terminal is a terminal emulation application 
that can be found in the Ubuntu MATE menus at Menu ► 
System Tools ► MATE Terminal. It provides access to the 
powerful Linux command line and interprets and executes 
the commands that you type at a command-line prompt.

You don't need to know how to use the command line to use 
today's modern Linux distributions, but understanding the 
basics can help you to simplify some common tasks by using
single-line commands, automating repetitive tasks with 
simple scripts, and using additional features not available in 
graphical versions of applications.

Although the MATE Terminal can be used to launch 
graphical applications by simply typing the name of the 
application and pressing the Enter key, you normally use it 
to run applications that are not designed to be run as 
graphical applications. These text-based applications, known
as command-line programs, can be used to create scripts 
and other programs, get and install additional software from 
the software catalog, check the status of your computer's 
hardware and installed software, and many, many other 
things. In fact, years before graphical applications were 
made popular for computing, computer users checked email,
communicated with other computers, shared files, photos, 
and programs, and even browsed early versions of the 
Internet from terminal applications very similar to the MATE 
Terminal.

Note: How to use terminal and command-line programs is a 
topic that has been explored in many books, so I won't go into 
more detail here. One popular and excellent book on this topic is 
"The Linux Command Line: A Complete Introduction" by 
William E. Shotts Jr. 
https://www.amazon.com/dp/ASIN/1593273894
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Another source of information on using the terminal is the MATE 
Terminal manual contained within the MATE Desktop User 
Guide. It's provided with Ubuntu MATE. To go there directly, 
open the MATE Terminal application from the menu, then press 
the <F1> key on your keyboard to open the manual.

How To Install Applications Using Apt On The Command
Line

As an example of how to use the command line, let's look at 
the apt application. It is a powerful command-line tool which 
can be used to install new software packages, upgrade 
existing software packages, update the package list index, 
and even upgrade the entire Ubuntu MATE system.

It's good practice to ensure that you have the latest changes 
made in the Ubuntu software repositories before installing 
software. The apt command can be used to update the index
of available software packages that are on your computer. 
To do this, type the following in the terminal window:
sudo apt update

Note: When you use "sudo" you are telling Ubuntu MATE that 
you want to run the command as administrator, so for security 
purposes, you will be asked for your password the first time you 
use "sudo" in a terminal session.

Also note that what you type in the terminal is case-sensitive. 
"Install" is not the same as "install". As far as the terminal is 
concerned, they are two entirely different words.

Installing software using the apt tool is quite simple, provided
you know the name of the application, and provided it is 
available in the software catalog. For example, to install the 
audio recording and editing application Audacity, type the 
following into a terminal window at the command prompt:
sudo apt install audacity
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Uninstalling (removing) an application is just as easy. To 
remove the Audacity application installed in the previous 
example, type the following:
sudo apt remove audacity

Adding the "--purge" option to "apt remove" will remove the 
package configuration files as well. This may or may not do 
what you want, so use it with caution. Here's how that looks 
using our same example:
sudo apt remove --purge audacity

Over time, updated versions of packages currently installed 
on your computer may become available from the package 
repositories. To use the command line to upgrade the 
applications on your system, first update the package index:
sudo apt update

When that command has finished running, type the following
to complete the upgrade:
sudo apt upgrade

How To Install Snap Packages On The Command Line

In addition to installing applications from the Ubuntu catalog, 
you can use the command line to install "snap" applications 
from the catalog of applications provided by the snap store. 
Snaps are application packages for the Linux desktop, cloud,
and IoT that are easy to install, secure, cross-platform, and 
self-contained. Since support for snap packages is included 
with Ubuntu MATE you can install from the snap store with a
simple command. The specific command you'll need can be 
found within the application's listing in the snap store 
(snapcraft.io/store). For example, to install the version of 
Audacity available in the snap store, the command listed in 
the snap store is:
sudo snap install audacity

- 94 -



Simple, right? Since snap support is built-in to Ubuntu 
MATE, snap applications receive automatic updates just like 
everything else!

How To Install Flathub Packages On The Command Line

As of Ubuntu MATE 22.04, another source of applications is 
Flathub. This source allows you to use the command line to 
install "flatpak" applications from the catalog of applications 
provided by the flathub app center. Flatpaks are easy to 
install, cross-platform, and self-contained applications for 
Linux distributions. Support for flatpack packages can be 
enabled from the Software Boutique. Once flathub support is
enabled, you can install flatpaks from the app center with a 
simple command. The specific command you'll need can be 
found within the application's listing in the flathub app center 
(flathub.org/apps). For example, to install the version of 
Audacity available in the app center, the command is:
sudo flatpak install flathub 
org.audacityteam.Audacity

Note: Type this command all on one line in the terminal.

To remove the Audacity flatpak, run this command:
sudo flatpak uninstall flathub 
org.audacityteam.Audacity

Note: Type this command all on one line in the terminal too.
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How To Display Your System Info Using The "lshw" 
Command

A graphical tool is great for a nicely-formatted overview of 
your system, but with a terminal and a few commands, you 
can really dig under the hood of your Ubuntu MATE 
computer's hardware. You can also use the command line to
reveal additional information stored in text files on your hard 
drive. 

Typing the "list hardware" command, lshw, at the command 
line without any switches or options to get a very detailed 
list. It needs to run as root (administrator), so you'll need to 
type "sudo" in front of the command. 

The list this command generates seems to run on forever 
and is a little difficult to follow when it is simply displayed in 
the terminal. The command listed below runs lshw with the -
html option to create an html file. Open it in a browser and 
you have a nice "web page" with all of your hardware specs.
sudo lshw -html>myhardware.html

When I ran it, this command detected and reported on my 
touch screen, attached USB storage drives, and even the 
micro-SD card on the phone I had charging on a USB port!

How To Display Your System Info Using The "inxi" 
Command

Possibly the easiest command to use in the terminal to get a 
full listing of your computer's system configuration 
information is the "inxi" command. To install "inxi", type use 
"apt", as we learned in a previous section: 
sudo apt install inxi
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Once the application is installed, to display your system 
information with a moderate amount of detail, as shown in 
the illustration below, simply type:
inxi -F

For a more verbose set of information, use 
inxi -Frmxx

For just the very basic info, type simply 
inxi
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Control Center

 The Control Center provides you with a single window
that houses all of the major Ubuntu MATE preference tools. 
These tools let you tweak the way things look and behave, 
manage software updates, and make adjustments to the 
printing system, among other things. 

Simply click the icon for the preference you want to adjust. 
Each of these preferences is also available under the Menu 
► Preferences menu. The items in the menu correspond to 
the items in the Control Center.

You'll also find many of the settings and selections you can 
make from within the Ubuntu MATE Welcome application 
are also available in the Control Center. The Control Center 
simply provides a central point from which you can adjust 
almost any system-level setting for your Ubuntu MATE 
computer.

Note: For more help on this application, see the Configuring 
Your Desktop topic in the "MATE Desktop User Guide". Simply 
click on the desktop (the background wallpaper) then press the 
<F1> key on your keyboard to open the "MATE Desktop User 
Guide".
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How To Use Ubuntu MATE's Applications

 Many of the applications you would expect to find 
installed on a modern computer are provided, pre-installed 
on Ubuntu MATE. Highlighted here are applications that you 
will likely use regularly. If you don't find an installed 
application to do what you want to do, you'll likely find it in 
the Software Boutique or by using one of Ubuntu MATE's 
other software management applications, then you can 
install it from there. See the topic "Installing Additional 
Applications" for more information about installing software.

How To Use Ubuntu MATE's Productivity 
Applications

Here is a sampling of some of the productivity applications 
you'll find as soon as you start using Ubuntu MATE and a 
few extras as well. Unlike with Windows and macOS, Ubuntu
MATE provides you with all of the pre-installed applications 
at no charge. And the vast majority of the software available 
in the software repositories is also free of charge. 
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Firefox Web Browser

 Pre-installed with Ubuntu MATE, Firefox is a popular 
application on almost any computing platform that delivers 
safe, easy web browsing. A familiar user interface, enhanced
security features including protection from online identity 
theft, and integrated search let you get the most out of the 
web. Firefox also provides features such as changing your 
home page, searching the web, bookmarking a site, and 
using a private browsing mode. You can also synchronize 
your Firefox bookmarks, history, passwords and more 
between your devices. 

Note 1: For additional help with Firefox, go to the Firefox help 
site at https://support.mozilla.org/products/firefox.

Note 2: Prefer a different or additional browser? The Welcome 
application's Browser Selection option offers Google Chrome, 
Chromium, Opera, Vivaldi, Brave, and Edge in addition to 
Firefox. Choose one or choose them all. It's your choice! 
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Evolution Mail And Calendar

 Web-based email programs that come from your 
Internet service provider (ISP) and Internet mail systems like
Yahoo Mail and Google's Gmail are convenient to use 
because they allow you to read and send email from any 
device. The only thing you need to run these is a web 
browser and an Internet connection. Many ISPs provide 
email clients that you can use to read and respond to your 
email off-line as well. Unfortunately, those off-line programs 
are usually applications for Windows. Many ISPs also give 
you the option of using their online email in conjunction with 
almost any computer-based email client that can handle 
POP mail or IMAP mail. Evolution allows you to access your 
personal information like your calendars, mail, address 
books and tasks in one place.

Evolution's features work with Exchange and Google 
servers, web calendars, RSS readers, and other services 
you might use.

If you use the automatic account configuration, setting up a 
new account with Evolution is easy. The first time you run 
Evolution, it opens the First-Run Assistant. It helps you set 
up email accounts and import data from other applications. 
All you need to do is provide your username and password 
for your email provider and your email address.

Note: To learn more about how to use each of the features of 
Evolution , see the "Evolution Mail and Calendar Manual" by 
pressing the <F1> key on your keyboard while Evolution is open.
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LibreOffice Office Productivity Suite

 LibreOffice is a full-featured office productivity suite 
that provides an alternative for Microsoft's office suite and 
Google's online office suite. LibreOffice let's you open, save, 
and create documents in Microsoft's proprietary formats as 
well as truly open source native file formats. Like other office
suites, LibreOffice includes several applications but unlike 
other suites it also includes applications like Base and Math, 
as a basic part of the suite. Unlike many online office suites, 
LibreOffice does not limit you to only the basic functions 
most people use. Basic capabilities are fine until you need to
use one of those "advanced" features. Then you'll be looking
for something with all the features.

 Writer, the word processor. 
Compare with Microsoft Word and Google Documents.

 Calc, the spreadsheet application. 
Compare with Microsoft Excel and Google Sheets.

 Impress, the presentation engine. 
Compare with Microsoft PowerPoint and Google Slides.

 Draw, the drawing and flowcharting application. 
Compare with Microsoft Visio and with inserting a drawing into 
a Google Doc.

 Base, the database and database front end. 
Compare with Microsoft Access.

 Math, for editing mathematic formulas. 
Compare with Microsoft Equation editor and the Auto-Latex 
Google Docs add-on.

Note: The Document Foundation (the organization behind 
LibreOffice) maintains an excellent set of documentation online 
for LibreOffice at https://documentation.libreoffice.org
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Bluetooth Connectivity

 Ubuntu MATE provides the software you need to 
support Bluetooth connections to headphones, mice, 
keyboards, or other computing devices. 

How To Connect Devices (Pairing)

In order to use a Bluetooth device like a mouse or a headset,
you first need to connect (pair) your computer and the 
device. Before you begin, make sure Bluetooth is enabled. 
Some computers allow you to disable Bluetooth from 
BIOS/UEFI. Check your BIOS settings to ensure that, if you 
have this setting, Bluetooth is enabled. 

Some laptops have a function key or other button that 
toggles Bluetooth and/or Wifi on and off. If your computer 
has this capability, make sure that Bluetooth is enabled in 
that way as well.

1. Click the Bluetooth icon in the upper panel and 
select Devices. The Bluetooth device setup assistant 
will open to help you in configuring and connecting 
Bluetooth enabled devices.
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2. Make the other Bluetooth device discoverable or 
visible (or put it in pairing mode) and place it within 30
feet (about 10 meters) of your computer. Click 
Search. Your computer will begin searching for 
devices. 

3. If the device you want to pair is not in the list, click the
magnifying glass icon to begin the search again. 

4. Right-click on the device you want to pair and select 
Connect. The pairing should happen automatically. 

5. In the notification area, click Confirm to accept the 
pairing request.

Note: You need to finish your connection within about 20 
seconds on most devices or the connection will not be 
successful. If that happens, return to the device list and start 
again.
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How To Configure Notifications In The Indicator Applet

 The Notifications indicator displays text notifications, 
as well as notifications supplying additional media, such as 
sounds or icons. offers a “do not disturb" feature. When do 
not disturb is enabled, notifications will not be displayed but 
will be captured in the notification center for review. 

By selecting Indicators from the Look and Feel section of 
the Control Center, then choosing Date and Time in the left 
pane of the window, it's also possible to blacklist some 
notifications, so they are never stored by the notification 
center.
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Barrier

 Barrier is a magical, cross-platform application that 
allows you to use the keyboard and mouse from one of your 
computers, to control and interact with the desktops of other 
computers on the same network. Barrier is one of my 
favorite utilities. Although it's not pre-installed with Ubuntu 
MATE, it is available in the software repositories and the 
snap store.

With Barrier's graphical, drag and drop setup, you can be 
controlling multiple Linux, macOS, and Windows computers 
in minutes. You can set up and control up to 14 client 
computers running a mix of Windows Vista through 10, 
macOS 10.9.X and newer, Red Hat Linux REHL 6 and 7, 
Ubuntu (and derivatives) 12.04 LTS and up, and Debian. 

In the example below, the keyboard and mouse are 
connected directly to my Dell XPS 13 running Ubuntu MATE,
so we will be using those devices to control both this Linux 
computer, and an older HP G60 computer, also running 
Ubuntu MATE. The controlling computer is considered by 
Barrier to be the "server" but we don't need to worry about 
that terminology, since the setup doesn't require that you 
know that at all. Here are the steps that I used.

How To Install And Start Barrier

1. To install Barrier, open your favorite Linux 
distribution's software repositories, package 
manager, software center, application library, 
add/remove programs, or whatever it provides for 
getting new software. Search for "barrier". Check 
the version that is available. If it's earlier than 2.1.0,
then you might try either the Snap package or the 
Flatpack package. Both are available.
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2. Next, determine where your computers are (or will 
be) located. In my case, I have my XPS 13 laptop 
sitting in the center of my desk. I have my G60 
computer on the right side of the desk. My 
keyboard and mouse are in a keyboard tray 
between the two, and are connected directly to the 
Dell XPS 13. Although I also have a Windows 10 
computer to the left and a monitor for my Macbook 
Pro on the wall above the Dell, we won't consider 
them for purposes of these instructions. Once you 
have Barrier installed on all client computers, the 
configuration steps are the same as for the HP G60
described here.

3. Open the Barrier application on each computer. For
most Linux distributions, Barrier is located in 
Applications or Menu ► Accessories ► Barrier.

On my Dell (the controlling computer) in the Barrier 
dialog box after the Welcome screen, I selected the
Server check box, and click the Configure Server 
button.
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4. On the configuration screen, double-click the 
picture of the computer in the center of the window 
and enter your computer name as the Screen 
name. 

When I installed Ubuntu MATE on my Dell, I named
the computer "xps13" so that is what I entered. 
Click OK to save the settings.

5. Drag the monitor icon from the upper right onto one
of the 14 vacant squares. Since my HP G60 is on 
the right, I dropped the icon to the right of the 
XPS13's icon. I double-clicked on the "Unnamed" 
icon that was just created. When I installed Ubuntu 
MATE, I named the computer "G60-230US", so 
that's the name I used for it's Screen Name. Click 
OK to save the settings.
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6. Click OK when you have completed the setup, then
click Start to start Barrier on the XPS13 computer.

7. To set up the G60, we need the IP address from 
the XPS13 computer. To display the IP address, 
click the Network icon in the Ubuntu MATE 
notification area and select Connection 
Information. The IP address in the IPv4 section is 
the one you want. Now, on the G60, in the Barrier 
dialog box, check the Client box and enter the IP 
address of the XPS13 as the Server IP.
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8. Click the Start button, wait a second or two, and 
the two computers are connected. To test it, move 
the mouse to the right edge of the XPS13 screen 
and beyond. It appears at the left edge of the G60 
screen! Now when you type on the keyboard, your 
text will appear on the computer where the mouse 
is located.

How To Use Caffeine

 With a coffee cup for an icon, Caffeine is a status bar 
application which sits in the panel near the clock and 
prevents the desktop from becoming idle. Simply click on the
icon and choose Activate to temporarily prevent the 
activation of both the screensaver and the "sleep" power 
saving mode. Click the icon again and choose Deactivate to
go back to normal. 

Caffeine is not installed out-of-the-box with Ubuntu MATE, 
but it is available at no charge in the Software Boutique for 
one-click installation.
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How To Use Ubuntu MATE's Document 
Management Applications

Ubuntu MATE makes printing, scanning and saving 
documents almost easier than creating them. All the 
software you are likely to need is pre-installed for most 
popular printers and scanners, so setting up your hardware 
is easy, too.

How To Add A Printer

 Printing on Ubuntu MATE is simple and easy. The 
most popular printer drivers are already provided in Ubuntu 
MATE's Linux kernel. In most cases you simply connect your
printer via its USB cable and Ubuntu MATE immediately 
configures it for use. There is nothing to do but start printing. 

If you need to configure a network (or wireless) printer 
manually, you can follow these simple steps. Before you 
start, ensure that the printer is turned on and connected to 
the same network as your computer.

1. Open the Printers application at Menu ► 
Administration ► Printers. 

2. Click Add. 
3. Click on Network Printer to view the network printers

automatically detected by Ubuntu MATE.
4. Select the printer from the list and click Forward. 

Note that a driver has been automatically selected for 
you. If your printer driver is not automatically selected,
you can select the manufacturer and the model from 
the database of drivers when prompted.

5. On the next screen, you can accept the suggestions 
provided or you can name your printer, give it a long 
description and even name its location.

6. Click Apply to complete the configuration.
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7. Print a test page to verify the setup and you are ready
to begin using your network printer.

How To Scan A Document

 The Simple Scan application, found in the Ubuntu 
MATE menus at Menu ► Graphics ► Simple Scan, 
provides a simple and easy way to scan your documents. 
Once your scanner is connected via USB or over the 
network, the configuration is usually automatic. 

Using Simple Scan is as easy as: load your document, press
Simple Scan's Scan button, then save the image. 

Note: For more information about how to use Ubuntu MATE's 
more advanced scanning capabilities, view the "Simple Scan 
Manual" by pressing <F1> while Simple Scan is open. 
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How To Create A PDF

 Whether you are scanning a page, writing a book, or 
saving a web page, you sometimes need to make a PDF file 
from a document. You don't need a special application with 
Ubuntu MATE. PDF creation is built-in. Most applications 
provide a menu selection to Save As PDF or Export to 
PDF. If the application you use does not offer one of those 
options, Ubuntu MATE provides the ability to print a 
document or file in PDF format. See the Print to File option 
in illustration below.
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How To Use The Entertainment Applications

Ubuntu MATE comes pre-installed with three significant 
applications for managing your entertainment and media 
files and subscriptions. If you need more, the software 
repositories offer much, much more to choose from.

Rhythmbox Music And Podcast Manager

 Rhythmbox, found in the Ubuntu MATE menus at 
Menu ► Sound & Video ► Rhythmbox, is a very easy to 
use music playing and management program which supports
a wide range of audio formats (including MP3 and ogg). 
Originally inspired by Apple's iTunes, Rhythmbox is much 
easier to understand and use, and it supports Internet Radio,
iPod integration and generic portable audio player support, 
audio CD burning, audio CD playback, music sharing, and 
podcasts. 

How To Subscribe To A Podcast With Rhythmbox

1. Click Podcasts in the Rhythmbox's left pane.
2. Click the Add button in the button bar. The search 

pane opens.
3. Type a search term or you can type or paste the link 

for the podcast feed into the search field.
4. Click Search. Podcasts matching your search appear 

in a list below the search.
5. Select the podcast you want from the list and click 

Subscribe. The episodes are added to the playlist 
and Rhythmbox immediately begins downloading the 
latest episode into a folder named for the podcast 
within your Music folder. Rhythmbox checks 
periodically for new episodes of each podcast and 
downloads them for you.

6. Click Close to hide the search pane.
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To play an episode, select one from the list and press the 
Play button. You may wish to click on the header of the Date
field to sort the episodes so that the latest episode is at the 
top of the list. As long as you have an Internet connection, 
you can play any of the older episodes without downloading 
them. Right-click any episode in the list to see an option to 
download that episode.

Note: For more information on how to use the playlist and other 
features of Rhythmbox, see the "Rhythmbox Music Player 
Manual" by pressing <F1> while Rhythmbox is open. 
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Shotwell Digital Photo Organizer

 Shotwell, found in the Ubuntu MATE menus at Menu 
► Graphics ► Shotwell, is a digital photo organizer. It 
allows you to import photos from disk or camera, organize 
them in various ways, view them in full-window or full-screen
mode, and export them to share with others. It is able to 
manage photos in many different image formats, including 
raw CR2 files.

When you first launch Shotwell, it scans your computer for 
photos and imports them so that you can use Shotwell to 
organize them. Once you have all the photos from your 
computer's hard drive within Shotwell, you can import new 
files by choosing File ► Import From Folder from the 
menus, or by dragging and dropping them onto the Shotwell 
window, or by connecting a camera to your computer and 
choosing to import the photos from there. 

With Shotwell, you have several features to help you 
organize your photos. You can group photos that were taken
at the same time into events, then rename, merge and sort 
events. Flag photos to mark them as special, or to work with 
them as a set. You can also search for, rate, tag, and title 
your photos.

Shotwell also provides the ability to edit the photos 
themselves. You can change the date and time of photos 
where they are incorrect, crop photos, remove red-eye, auto-
enhance to improve brightness and contrast, rotate or flip a 
photo, and even straighten photos taken at an angle.

Of course, you can share your photos from Shotwell by 
exporting or printing them. You can also publish them to 
Facebook or other online sites, send them via email or 
instant messaging, or simply display them as a slideshow.

Note: To learn more about how to use each of the features of 
Shotwell, see the "Shotwell Photo Manager Manual" by pressing 
<F1> while Shotwell is open. 
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Celluloid Media Player

 Celluloid, found in the Ubuntu MATE menus at Menu 
► Sound & Video ► Celluloid, is a simple media player 
that aims to be easy to use while maintaining high level of 
configurability. Playlist entries can be added, removed, or 
rearranged easily with drag and drop operations.

Note: Linux Spotlight is © 2022 by Rocco (Big Daddy Linux) 
https://bigdaddylinux.com/video/episode-26-martin-wimpress/
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How To Use Ubuntu MATE's Security 
Applications

 The Linux operating system is more secure, and 
better supported than the operating systems pre-installed on 
most home computer hardware today. Linux is backed by 
many large corporations, as well as independent developers 
and users, many of whom are focused on ensuring and 
improving the security that is built into the operating system. 
The built-in updater provided with the Ubuntu MATE 
distribution of Linux provides security updates for both its 
software applications and the operating system. 
Vulnerabilities are patched more quickly and are delivered 
automatically and more frequently than the two most popular
operating systems.

Unlike operating systems that update only once a month, 
Ubuntu MATE receives updates continuously. The updates 
include security patches for Ubuntu MATE and its installed 
applications and are all provided on the same frequent 
schedule. This ensures that you have the latest protection 
for all of your computer's software -- as soon as it's 
available!

Ubuntu MATE is designed to make it difficult for viruses, 
rootkits, and other malware to be installed and run without 
conscious intervention by you, the user. Ubuntu MATE users
are not administrators by default. Administrators ("root" 
users) on any computer system have permission to do 
anything they want, including doing damage to the system. 
To be extra secure, Linux requires you to provide your 
administrator password to install or run programs as root. 
Every single time.
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Basic Linux Security Guidelines

The Canonical website lists 35 Linux Trojans, viruses and 
worms in its published lists and av-test.org records over 
250,000 new malicious (mostly Windows) programs daily...

 If you dual-boot with Windows, run Windows in a VM, 
use WINE, or simply share files with Windows-using 
friends, scan the files for viruses.

 Enable the Ubuntu MATE software firewall. 
 Keep your system updated. Updates are automatic on

most Linux distributions. Let them run as soon as they
are available.

 Use strong passwords. On everything. And use a 
secure password manager to store them.

 Make backups regularly.
 Install software only from trusted sources.
 Use security-related plugins for your Internet browser.
 Use your common sense. The biggest security threat 

is generally found between keyboard and chair.
The Ubuntu Wiki provides additional recommendations on 
Basic Security at https://wiki.ubuntu.com/BasicSecurity. 
Their security tools and concepts include these categories:

 Your Tolerance for Risk
 Linux Vulnerabilities Myths and Reality
 Know What Sudo is Doing
 Don't Log in as Root
 Encrypt Your Home Folder
 Least Privileges, Always
 Know What You Have, Have What You Know
 Home Network
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Backups (Déjà Dup)

 Ubuntu MATE comes pre-installed with a backup 
utility called Déjà Dup. The application is found in the Control
Center at Menu ► Control Center ► Backups. Reinstalling
an operating system again after something goes horribly 
wrong is annoying at best, but losing your photographs, 
emails, and personal documents can be a devastating loss 
of priceless, irreplaceable valuables. Backing up the 
information on your hard drive on a regular basis is critical 
for anyone who uses a computer routinely. You have spent 
hours on end producing the information that is on your hard 
drive. You should routinely back up at least your new data 
files on a weekly basis. "Data" files include databases, 
documents, spreadsheets, etc. Anything YOU created, 
imported, or downloaded onto your hard drive is a data file.

If you are prepared to restore from a backup, then you are 
far more secure. It is important to make backups right before
performing certain risky operations like upgrading to a new 
operating system version, moving a large number of files 
around, deleting files and folders, etc. Déjà Dup even lets 
you automate your backups for added convenience and 
safety.
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In the event that your computer has a digital disaster, or you 
are concerned that it has an infection, your backups will 
ensure that you can restore Ubuntu MATE to a known 
previously good state. 

Note: For additional help on using this application, see the Déjà 
Dup manual by pressing F1 while Déjà Dup is open.

How Do I Know What And Where To Backup?

Your computer may be able to save data onto CDs, DVDs, 
Zip Drives, Jaz Drives or even floppy disks! That's fine for a 
file or two, but today your best option for practical backups is
to use online storage or an external hard drive. 

On a typical recordable CD, you could store up to 700 
megabytes (MB) of information while DVDs could store up to
8.4 gigabytes (GB). Blu-ray discs are a more recent type of 
optical media. They can hold up to 50GB of data. With the 
size of files these days, you might get one or two video files 
on a DVD. If you have a file that is larger than 700MB, like a 
moderate LibreOffice Impress presentation file, or a Writer 
document with graphics, an ordinary CD has no hope of 
holding even one whole file.

The focus of this topic is on making backups to hardware 
devices. If you don't have a network attached storage (NAS) 
drive on your home network, you can readily purchase an 
external drive with multiple terabytes (TB) of storage 
capacity, or even an inexpensive portable USB external 
drive more than large enough to hold the data from most 
computers' hard drives today.

When backing-up data files, it is not always necessary to 
backup every file you have on your hard drive, although it's a
good idea to do so monthly. On your Ubuntu MATE 
computer, few files, if any, outside of your "home" folder 
need to be backed-up at all. If a disaster were to happen, 
and you lost your computer or your hard drive, you could 
simply reinstall the Ubuntu MATE operating system and your
applications in well under an hour, then restore the backed-
up contents of your "home" folder. 
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Your "home" folder contains the information that you have 
created yourself, including your mail file, and the settings 
and preferences for most of your applications. Ubuntu 
MATE's Caja file manager is shown in the illustration below, 
copying the "home" folder to an external USB drive.

If you have a home network you may be lucky enough to 
own a multi-terabyte hard drive accessible to any computer 
on the network. Large external hard drives have become so 
inexpensive that it is wise to include an external hard drive in
your budget when you are buying a new computer. 

Instead of being stored on your computer's hard drive, the 
files you copy to an external or networked drive are stored 
safely off of your computer. That way, if something happens 
to your computer's internal hard drive, or if your laptop is 
stolen, all your files are safely stored on an external device.

An equivalent to a network drive (well, sort of...) is an online 
(off-site) storage service like Dropbox, Box, Google Drive, or 
SpiderOak. The advantage to this kind of backup is that your
files are stored on the Internet. Even if the worst were to 
happen, and you lost everything to a fire or flood, your 
backups would be safe. And if you copy your files to online 
storage, you will also likely be able to access them from 
another computer, a tablet or smartphone!
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Backing Up Your Computer Is Cheap Disaster Recovery 
Insurance

One way to backup inexpensively is to get a large 
thunderbolt, USB-C, or USB 3 external hard drive and copy 
everything in your "home" folder to it on a regular basis. And 
perhaps the easiest way to ensure that you make your 
backups regularly is to automate the process using the 
backup software that comes pre-installed with Ubuntu 
MATE.

At least monthly, you should make a complete backup of 
everything important on your hard drive either by using 
backup software or by simply copying to a second hard drive
or a network drive. Linux applications such as the pre-
installed Ubuntu MATE Backup (Déjà Dup) application can 
automate these backups for you. You do this so that if your 
computer or hard drive were to be stolen, destroyed or 
damaged beyond repair, you would have a "disaster 
recovery" copy. From a "disaster recovery" copy, you could 
restore your entire "home" folder to the condition it was in, at
the time of your last backup. If you do such a complete 
backup monthly, the worst case would be that you would 
have to restore less than a month's worth of additional data 
from your incremental data backups. (Incremental backups 
contain only what has changed since your last full backup.)
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How Often Should I Backup?

In reality, how often you should backup depends on several 
factors. In general, the more you use your computer or the 
more critical the work you are doing, the more often you 
should back up.

As a general guideline, you should use the external drive 
and/or your online storage to make a complete backup of 
your entire hard drive every month. So that you don't forget, 
automate the process using the backup software pre-
installed with Ubuntu MATE. You can even set up the 
Backup application so that it copies only new files, and 
updates new versions of files on your computer to the 
backup device, never deleting anything from the copy. What 
a lifesaver that can be!

Use an online service or external hard drive to make a 
monthly full backup. In addition, each week you should back 
up your critical data files in an incremental backup onto your 
external storage, or to your online storage. Incremental 
backups can be automated, too.

Don't wait. Setup a scheduled backup right now -- or you will 
wish you had!
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How To Update Your Ubuntu MATE And Its 
Applications

 The Software Updater available from the Ubuntu 
MATE Welcome app or from the menus at Menu ► 
Administration ► Software Updater is the update 
manager for your system. Ubuntu MATE periodically checks 
to see if new software and security updates are available for 
your computer. The updates are for Ubuntu MATE, all of its 
components, and all of your installed applications. This 
ensures that you have the latest updates and protection for 
all of your computer's software as soon as it's available, not 
just once a month like other operating systems.
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How To Use The Software Updater

After you launch the Software Updater from the menus, if 
updates are available, the application lists the updates and 
asks if you want to install them now. Click Install Now to 
begin the download. The dialog shown below appears while 
the update is in progress and another appears once the 
update is complete.

Note: If Ubuntu MATE cannot install all of the updates and 
upgrades at once, you will see an option to perform a partial 
upgrade. You should normally choose that option, restart if 
required, then check for additional updates using the Software 
Updater.

How To Manage The Updates

You have control over when and how software updates 
occur. Use the Settings button on the Software Updater 
screen, or from the menus, choose Menu ► Administration
► Software & Updates, then select the Updates tab.
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These are your options for controlling updates to Ubuntu 
MATE and its applications:

 You can choose from options to install "Important," 
"Recommended," "Unsupported" or any combination 
of these updates. 

 You can have the updater automatically check for 
updates every day, every two days, every week, every
two weeks, or turn off automatic checking altogether. 

 You can have the updater automatically download and
install security updates, download but not install them 
or simply display the updates so you can choose 
whether to download and install. 

 For other updates (other than security updates) you 
can choose to display available updates as soon as 
they are available, weekly, or every two weeks. 

 You can also choose to be notified whenever there is 
a new release of Ubuntu MATE, only when there is a 
Long-Term-Support (LTS) release, or never.
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How To Setup The Firewall

 Ubuntu MATE's Firewall Configuration utility (Gufw), 
found in the Control Center at Menu ► Control Center ► 
Firewall Configuration, provides an uncomplicated way to 
manage your firewall settings. The firewall is not enabled by 
default in Ubuntu MATE because, by default, Ubuntu MATE 
does not open ports to the outside world. If you do choose to
enable the firewall, and if you are a normal user, you will be 
safe with these settings:

 Status = On 
 Incoming = Deny
 Outgoing = Allow 

There is no need to set the firewall to autostart. After you 
change the settings they will take effect immediately and 
remain in place until you change them again. 
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Appendices

Appendix A: How To Use Keyboard 
Shortcuts

 Ubuntu MATE has many keyboard shortcuts that, by 
pressing a combination of keys, help you do things that 
normally require a mouse, trackpad, or another input device. 
This section begins with a comparison of these keyboard 
shortcuts with those you might have used in your previous 
operating system. Later, there are some details on how to 
change the default key bindings. 

Note: Changing your theme or window manager in the MATE 
Tweak tool might change some of these shortcuts. These 
changes in behavior are indicated in the descriptions and tables 
that follow.

Every major operating system makes use of a special 
hardware "meta key" on the keyboard. They are listed below,
and for the purpose of running Ubuntu MATE on your 
computer hardware, the keys are equivalent with one 
another. In Linux documentation, the "meta key" is often 
referred to as the "super key".

Key Description

Apple macOS Command key (used on Apple keyboards)

The Microsoft Windows logo key (used on Microsoft-branded and many 
generic keyboards)

The Ubuntu logo key or Tux penguin logo key, also known as the "Super" 
key (used on keyboards of some computers pre-installed with Linux)
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Your keyboard's meta key can be used by Ubuntu MATE to 
activate menus and launchers as well as the many keyboard
shortcuts that include the "Super" key.  

For example, as they are for users of the MATE Desktop in 
other Linux distributions, both the <Super> + L and the 
<Ctrl> + <Alt> + L key combinations are recognized as 
screen lock keyboard shortcuts in Ubuntu MATE.

Do You Need To Enable The Super Key?

The Super key just works after you install Ubuntu MATE on 
most computer hardware. However, when you order a 
computer pre-installed with Linux from the manufacturer 
Dell, you will need to follow Dell's instructions on how to 
enable the Super key. Details are available from Dell's 
support website in a knowledge base article entitled, "How to
enable the Ubuntu super key on Dell OEM Ubuntu 
installations." 

Check your hardware manufacturer's documentation or 
website to determine if your computer's Super key requires 
similar setup. 
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Common Application Shortcuts

These shortcuts apply in most applications.
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Window Shortcuts

These shortcuts help you manipulate windows with your 
keyboard.
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Desktop Shortcuts

These are shortcuts you can use to operate parts of the 
desktop.

How To Create Custom Keyboard Shortcuts

If you have been using keyboard shortcuts you may be 
wondering how to create your own to be more productive. In 
fact, you may find that, as in the example, you actually need 
to create one. These how-to instructions provide the step-by-
step for Ubuntu MATE. 

For Ubuntu MATE and for Windows, the Print key and the 
Alt + Print key combination are the designated methods of 
taking a screenshot, but some wireless keyboards don't have
a Print key. You can use the Keyboard Shortcuts utility in 
Ubuntu MATE's Control Panel to assign the screenshot 
application to any key combination you want. The command 
to run the Screenshot application is
mate-screenshot --interactive
You can choose any available key or key combination you 
wish for your keyboard shortcut. Ubuntu MATE will warn you
if you try to assign a combination that's already assigned to 
something else. For our example, since Alt + Print isn't 
available we will use the combination Alt + 4 to select and 
then capture a portion of the screen.
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1. Open the Control Center from the main menu and 
select Keyboard Shortcuts.

2. Click the Add button to create a new custom 
keyboard shortcut.

3. In the Name field, type "Screenshot".
4. In the Command field, type "mate-screenshot --

interactive".
5. Click the Apply button to save the settings.
6. To assign a function key or other hardware key, in the

list of custom shortcuts, locate the Screenshot 
shortcut and double-click on the word "Disabled" to 
change it to "New Shortcut..." and then press the key 
combination you want use (Alt + 4) then press the 
Tab key to activate the shortcut.

7. Finally, close Keyboard Shortcuts and try the 
shortcut to make sure it works.

Now that you know how to make your own custom keyboard 
shortcuts, why not think of other shortcuts that you might use
to be more productive.
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Appendix B: How To Try And Install 
Ubuntu MATE

How To Create Installation Media

 Start by downloading the Ubuntu MATE image file 
from the website. See full instructions at 
https://guide.ubuntu-mate.org/#about-downloading. 

The .iso file you download from the Ubuntu MATE website 
doesn't do you much good on its own. You need to put that 
file in a form that will allow you to install it on your computer. 
This section describes how to create the installation media 
(CD, DVD or USB device) that will allow you to do just that. 
As a note, installable media is often referred to as "live" 
media because using this method you run Ubuntu MATE 
directly from the media, live. This allows you to try Ubuntu 
MATE on your computer without installing, and without 
changing anything at all on your computer. When you shut 
down and remove the "live" media, your computer is back to 
normal.

To install and try Ubuntu MATE from a USB drive or SD 
card, you'll need media with at least 4 GB of memory and 
have downloaded a compatible copy of Ubuntu MATE for 
your system. (https://ubuntu-mate.org/faq/downloads) 
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You can also use a CD or DVD to install Ubuntu MATE, but 
this method is recommended only for older computers or 
where the computer can't be configured to boot from a USB 
device. For information on how to make a CD or DVD for 
installation using Windows, macOS, and Ubuntu, see the 
"Burning ISO HowTo" article on Ubuntu help. 
(https://help.ubuntu.com/community/BurningIsoHowto)

Most likely, if you are considering a switch to Ubuntu MATE, 
you are using Windows. If you are creating the bootable 
media from Windows, macOS, or a distribution of Linux, the 
post "Imaging a USB Drive" on the Ubuntu MATE website 
provides step-by-step instructions. 
(https://ubuntu-mate.org/faq/usb-image)

How To Prepare For Installation

Ubuntu MATE is relatively simple to set up, whether you're 
looking to replace your existing operating system or install 
Ubuntu MATE alongside an existing one - such as Microsoft 
Windows or another GNU/Linux distribution.

System Requirements

Ubuntu MATE is designed to run on almost any computer 
hardware. Of course, Ubuntu MATE runs particularly well on 
the newest, fastest hardware, but it also runs well on almost 
any vintage of machine. In fact, an older computer designed 
during the Windows Vista era can easily be outfitted with the 
new, modern and fully-supported Ubuntu MATE and it will 
likely run better than it did with the previously installed 
operating system. Of course, Ubuntu MATE will run much 
more efficiently if your computer meets or surpasses the 
recommended requirements. 

Note: For more information on the latest hardware requirements 
check out the Ubuntu MATE website: 
https://ubuntu-mate.org/about/requirements/
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If you have a newer computer that boots with UEFI, rather 
than the classic BIOS, you may need to disable "Secure 
Boot" or enable "Legacy Boot" before Ubuntu MATE can be 
installed. You may also need to disable RAID if your 
computer came with Windows 10 or 11 pre-installed. Check 
your computer manufacturer's website for details on how to 
do those things.

Step One: Backup!

Back up any important data to another storage device before
you start to install in case something goes horribly wrong! 
Save all of your important files and folders to an external 
USB drive or a 2nd hard drive. DO NOT save anything to the
same drive you intend to use for Ubuntu MATE. Once you 
start, there is no going back! Here is an article with some 
considerations around backups: Backup Strategies For Your 
Computer (https://goinglinux.com/articles/Backups.html)

Step Two: Plan For Recovery

If your computer has a recovery partition and your current 
system allows you to create recovery disks for your 
computer, stop reading and go do that now. If you decide 
that Ubuntu MATE is not for you, this will allow you to 
reinstall your original operating system. Then you can use 
the data backup that you made in step one to restore all your
data.

Step Three: Decide What To Do With The Recovery 
Partition

If your computer has a recovery partition, if you format over 
the recovery partition, you will not be able to recover your 
previous operating system. Only format or remove the 
recovery partition if you are certain that you don't want it 
anymore.
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How To Try And Install Ubuntu MATE

 Now that you've created the installation media, you've
done your backup, and you've planned for recovery (you DID
do all that right?) you are ready to install (or just try) Ubuntu 
MATE. For most relatively modern computers, the 
installation process will take well under an hour to complete. 
Stay connected to the Internet to install all available updates.
Plug your device into a power source if it is running on 
battery power.

1. Completely shut down your computer.
2. Insert the USB stick.
3. Start the computer and watch the screen to determine

which function key to press to change the boot 
device. The message flashes by quickly, right at the 
bottom edge of the screen, but the most frequently 
used keys are <F1> , <F2> , <F4> , <F12> and the 
<Del> key. It depends on your computer's 
manufacturer. If your computer boots up normally and
you don't see Ubuntu MATE startup, shut down and 
try again.

4. When you get to the screen that lets you change the 
boot device, select the menu entry that represents the
Ubuntu MATE live USB stick. Press the key that lets 
you boot using the USB stick. That's usually the 
<Enter> or <F10> key. If you need help, try the article
from How-To Geek (https://howtogeek.com): "How to 
Boot Your Computer From a Disc or USB Drive" 

5. After the disk is checked and the computer has 
started loading Ubuntu MATE, you will be given some
options. Select the option: Try Ubuntu MATE.
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6. Once Ubuntu MATE has booted successfully, you will 
be able to use the computer as though Ubuntu MATE 
were installed. It's not. It is running from the USB 
stick. The live session you are using provides a good 
opportunity to test Ubuntu MATE without modifying 
your computer, allowing you to test that all of your 
hardware and peripherals are working as intended 
before committing to installing it on your machine. 
Once you are ready, double-click the installation icon 
on the desktop.

7. You don't need to connect to the Internet to complete 
the installation of Ubuntu MATE, but if you want to 
use the web browser, or if you want to install 
additional updates during the installation, you should 
connect your network cable, or connect to Wi-Fi. Click
the Network Manager icon in the upper right corner 
of the screen (near the clock) and select your SSID 
for your wireless network. If prompted, enter the 
passcode, click the Connect button and you will be 
connected.
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8. To begin the installation, double-click the Install 
Ubuntu MATE icon on the desktop.

9. Select your language. Press the Continue button.
10. If you have an Internet connection, choose the option 

to download updates while installing. For first-time 
Ubuntu MATE users, you should also choose the 
option to install third-party software to ensure a 
smooth transition to your new operating system. 
Press the Continue button.

Minimal Installation
Minimal Installation is presented as a radio button option in the 
installer, it will install just the MATE Desktop, its utilities, its 
themes and Firefox. All the other applications such as office 
suite, email client, video player, audio manager, etc. are not 
installed. This is a useful option if you have minimal disk space 
or you wish to select applications other than the default software 
provided with Ubuntu MATE.

NVIDIA Drivers
If you have an NVIDIA GPU connected to your computer and 
select Install third-party software for graphics and Wi-Fi 
hardware during installation, the NVIDIA proprietary drivers will 
be installed.

After completion of your installation, the proprietary NVIDIA 
drivers are installed and configured. Ubuntu MATE users with 
laptops that support hybrid graphics will see the MATE Optimus 
hybrid graphics applet displaying the NVIDIA logo. MATE 
Optimus adds support for NVIDIA On-Demand and will prompt 
users to log out when switching the GPU's profile.
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11. If you are sure that you want to completely erase 
every trace of your previous operating system, 
choose the option: Erase disk and install Ubuntu 
MATE . If you are not sure, then choose the option: 
Install Ubuntu MATE alongside your original operating
system. This will allow you to choose which operating 
system to use when you start your computer. If you 
chose to install alongside, then press the Continue 
button.

12.Press the Install Now button.
13.Read the message on the screen to confirm your 

choices, then press the Continue button to start the 
installation.

14.Select your location. Press the Continue button.
15.Choose your preferred keyboard layout. Press the 

Continue button.
16.Enter your full name, a name for your computer, a 

username, and a password. You will use the 
username and password when you log into your 
computer. Press the Continue button.

17.Now wait just a few minutes while the installation 
completes, and updates are downloaded and 
installed.

18.Press the Continue Testing button if you wish to 
continue to use the live environment, or press the 
Restart Now button to reboot and log into your new 
installation of Ubuntu MATE!

19.When prompted, remove the installation medium, 
then press Enter . Your computer will restart (if that's 
what you selected) and you will be prompted for your 
password to complete the log in process.
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Appendix C: How To Submit Feedback On 
Problems

 How To Report Bugs In Ubuntu MATE

Ubuntu MATE provides an easy way to provide feedback to 
the developers when something isn't working right or things 
don't go as expected while using the software. If you 
discover non-crash hardware and desktop application bugs, 
reporting them to the developers is a great way to contribute 
to the project. 

Ubuntu MATE comes with a utility that lets you report a bug 
in a way that provides the developers with the details they 
need to address the issue. The utility, Apport, is launched as
the command "ubuntu-bug" and connects you directly with 
experts and developers via Ubuntu's Launchpad. For more 
information about reporting bugs with ubuntu-bug:

 https://help.ubuntu.com/community/ReportingBugs
 https://www.youtube.com/watch?v=27OhY83MsU8
 https://www.jonobacon.com/2012/02/28/tutorial-video-

reporting-a-bug-in-ubuntu/
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How To Report A Bug

When reporting a bug, you must tell Apport (the Ubuntu bug 
reporter) which program or package is at fault.

Press Alt+F2 to open the "Run Command" screen, then type
ubuntu-bug <package name> 
and click Run. 

Note: If you want to file a bug about a particular software 
application but you don't know what that application's package 
name is, if the application has an open window on your screen 
you are in luck. In a terminal execute the command: 
ubuntu-bug -w

After you close the dialog the next window that you click on will 
have a problem report created for the package that created the 
window.

Follow the prompts and answer the questions to gather 
information about where the bug occurs. You'll get an email 
when the status of the bug changes or if the developers 
need more information.
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Note: If are not sure which package is affected by the bug, 
simply type: 
ubuntu-bug

in the "Run Command" screen and press Enter. This will guide 
you through a series of questions to gather more information 
about the bug and help you assign it to the appropriate package.

How To Complete The Bug Report Filing Process

After running the above command, Apport will gather 
information about the bug. 

A window will then pop up, asking you if you want to report 
the bug. Click Send if you wish to proceed, or click Content 
of the report if you want to review the information Apport 
collected. 
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Apport will then upload the problem information to 
Launchpad, and a new browser window will open to inform 
you that the bug report is being processed.

After the bug report data has been processed, a series of 
screens will open that will ask you to provide a title for the 
bug report that will appear in all bug listings and allow you to 
select from a list of bugs that have already been reported or 
submit a new bug.

In providing additional information when prompted it's 
important that you specify three things:

 What you expected to happen
 What actually happened
 If possible, a minimal series of steps necessary to 

make it happen, where step 1 is "start the program"
You can also include an attachment such as a picture, video,
or document that helps illustrate the problem.

When you're done, click Submit bug report.
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Appendix D: Why Computer Users Switch 
To Linux

Why Users Switch From Windows

 In addition to common and well-founded concerns 
around security, I often receive questions and comments 
from Windows users who have, over time, become more and
more dissatisfied with Microsoft's operating system. It seems
that after purchasing and installing a new version of 
Windows or, more likely, after purchasing a new computer 
with the upgraded operating system pre-installed, those 
users are finding that they have to repurchase newer 
versions of the same software applications they already own,
just to have them work with the upgraded version of 
Windows. Switching to online, cloud-based software 
applications might at first seem to be a practical alternative. 
But those applications are often less capable and at least as 
expensive, especially after a year or more of paying monthly 
subscription fees! 

To add insult to injury, Windows users sometimes also have 
to pay for new accessories like printers and document 
scanners to replace perfectly functioning older models that 
require software that is no longer compatible with the 
"upgraded" version of the operating system. They are 
disappointed that the promise of a "free upgrade" from 
Windows 7 or 8 to Windows 10 has, in fact, turned out to be 
anything but free. In fact, they tell me, it can be at least as 
expensive as previous Windows upgrades have been.

And what about those security concerns? Today, Microsoft 
provides comprehensive updates and malware protection 
built into Windows. Most computer manufacturers who 
supply Windows with their hardware seem to feel that, to 
provide adequate protection from infection, they must 
provide additional third-party anti-malware and anti-virus 
software. 
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Although it's admirable that automatic updates are provided 
with the operating system, Windows users report that 
because of Microsoft's implementation of their update 
system, they are frequently forced to restart the computer 
right in the middle of their workflow! Sometimes there are 
updates with multiple restarts and delays that cannot be 
stopped or postponed. This can leave the computer 
unusable for a half-hour or more! That behavior sends 
Windows users looking for alternatives that allow them to 
stay productive all day long.

Why Users Switch From macOS

 Switching to Apple's macOS doesn't get you off of 
the treadmill of spending increasing amounts of money for 
software and hardware upgrades. If anything, it accelerates 
that treadmill. Apple's direction for product design seems to 
trend toward ever-more expensive products that eliminate 
printer, monitor, keyboard, mouse, and other accessory 
ports. They require expensive dongles and adapters just to 
connect common accessories! They've also been sealing 
shut the computer's case on newer models, eliminating the 
possibility of replacing or upgrading on your own, simple 
things like RAM, hard drives, and broken parts. Purchasing 
the latest hardware from Apple results in some previously 
functional software suddenly becoming incompatible. This is 
not the first time Apple users have experienced this kind of 
bumpy transition that makes them wait for older, Mac-
specific applications to be updated just so that they work 
again.

And what about those computer users who switched to the 
reportedly more secure macOS to avoid their security 
concerns with Windows? Third-party protection is also 
recommended for Apple's operating system and macOS also
forces updates, seemingly without warning, that can 
sometimes be neither stopped nor postponed. 
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Apple's forced reboots that cause periods of lost productivity 
are usually less frequent than Microsoft's but when they do 
occur they require you to pause your work for more than a 
few minutes while the updates are applied and the computer 
restarts. 

Why Users Switch From ChromeOS

 Google's ChromeOS has seen a surge in usage 
recently as computer users look for an economical way to 
take classes online and work from home. As users acquire 
inexpensive Chromebooks, many are finding that the 
device's performance is sluggish as compared with more 
capable PC hardware. They also find that doing everything 
within the Chrome browser and relying on web apps and 
performance-reducing browser plug-ins doesn't meet their 
expectations. Sometimes you just need to run a dedicated 
application on your computer's operating system to get 
things done! Disappointingly, Google has discontinued 
support and security updates for the oldest Chromebooks 
and they famously kill their apps, software, and hardware 
offerings with little notice. As a result, users may wonder 
how soon they'll lose access to the software and hardware 
they rely on for their daily computing and need to switch to a 
fully-functional operating system.
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Appendix E: Linuxes Key Differences

What Are The Difference Between Linux 
Distributions If They Are All Linux?

 When you are considering a switch to Linux it's easy to
become confused by the choice of so many versions. This 
book focuses on the fundamentals of desktop applications 
and recommends Ubuntu MATE for new switchers from 
other operating systems. If you would like to try other 
distributions, this section with help you make the choice by 
looking at some of the key differences between Linux 
distributions. 

When using Windows, macOS, or Chrome OS, your choice 
is limited. It seems like there is only one current version of 
each. In reality, there are different versions for different 
situations (like desktop, tablet, phone, home, business, and 
server versions) but they are all marketed as "Windows" or 
as "macOS".

So if they are all Linux, why are there so many distributions 
and what are the real differences? At first blush the most 
obvious differences between Ubuntu, Fedora, Linux Mint, 
Debian, openSUSE, and many other variants of Linux are 
cosmetic. The theme, style, and behavior of application 
windows are different.

WHY so many versions of Linux exist is deeper. The "why" is
rooted in the open source philosophy behind Linux. That 
philosophy is based on freedom. The freedom to use the 
software for any purpose you choose, to change it to suit 
your needs, and to provide your changes to others. In other 
words, the freedom of choice. Along with choice come all of 
the Linux Distribution options you can choose from.
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Each Linux distribution is a project unto itself, with a project 
leader who sets the project aims and goals and helps 
determine:

 What kind of computer user it's meant for.
 What software will be pre-installed.
 What Desktop Environment(s) the distribution will use.
 What Package format and package manager will be 

used.
 What Display server will be provided.

What Kind Of Computer User?

Linux distributions can exist to serve the needs of different 
kinds of computer users. For example, Linux Mint is based 
on Ubuntu, but contains different system tools, a different 
desktop environment, and a minty green theme. Its primary 
focus is on Windows and macOS users just starting to use 
Linux.

Debian, on the other hand, aims to provide an extremely 
stable distribution and therefore contains older, more stable 
versions of software.

Another way of looking at this is to ask, "What is the user 
trying to DO with Linux?" For example, there are gaming 
distributions like Steam OS, or multimedia distributions like 
Fedora Design Suite and Ubuntu Studio.

What Software Is Pre-Installed? 

Some distributions exist because the project's creators liked 
some aspects of an existing distribution but wanted to 
replace or add some software packages. 

The people behind each Linux distribution choose what 
software they include. They include the software they think 
will best fit the purpose of the distribution. For example, 
audio and video production apps for entertainment studio 
distributions, or a selection of easy to use software for new 
users.
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Another example: Several file managers are available for 
Linux, such as Caja, Nautilus, and Konqueror, each offering 
a different way to browse files. The project leaders 
determine which they will offer in their distribution.

Which Desktop Environment?

A desktop environment is the bundle of programs that you 
interact with the operating system and the software 
applications. The most visible place that distributions differ is
in which desktop environment they use.

For example, Ubuntu's official flavors offer several desktop 
environments depending on which flavor you choose:

 Ubuntu (the main version) includes the GNOME 
desktop

 Kubuntu uses KDE
 Lubuntu includes LXQt
 Ubuntu Budgie has the Budgie desktop
 Ubuntu MATE includes the classic Ubuntu desktop
 Xubuntu includes Xfce

Other distributions have a more modest selection of 
desktops available, often offered as "spins" each of which 
contains a different desktop environment. An example 
distribution that does this is Fedora. If you like the Apple 
look, you'll find the macOS-inspired Pantheon desktop on 
Elementary OS.

Which Package Format And Package Manager?

The people behind the distribution also choose the package 
format and package managers for installing the software 
packages.

On Debian-based distributions such as Ubuntu and Linux 
Mint, the package format is "deb" and program "dpkg" is the 
package installer, accessed via the apt dependency 
resolver. For CentOS, "rpm" is the package format and the 
package manager responds to commands using the 
program "yum".
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In addition to standard formats, there are also universal 
package types like Snap, Flatpak, and AppImage. Support 
for all of these can be installed on almost any Linux 
distribution if it's not provided by default. 

Which Display Servers?

A display server is a selection of tools, applications, 
processes, and servers that determine how Linux runs.

This software coordinates the communication of information 
between the computer hardware and the display, letting you 
interact with the graphical user interface (GUI).

Historically, the X.Org Server has been most commonly 
used. Various alternatives are available, however, such as 
Mir, and SurfaceFlinger which is used on Android (which 
uses the Linux Kernel). Wayland is seen as the future of the 
Linux display server with many popular distributions adopting
it.
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Summary

Although the desktop environment is the most visible 
difference between distributions, the Linux kernel is the 
software that runs under the hood that makes Linux Linux.

So even though the different distributions of Linux may look 
and behave differently and have different applications 
installed by default, they all have the benefits that Linux 
gives you. 

Desktop distributions of Linux are designed with security 
built-in and with protection from viruses and spyware 
included. Linux is secure, requiring minimal or no 
maintenance. Most desktop distributions provide automatic 
security updates and software upgrades for both the 
operating system and all of your installed applications. Linux 
security is upgradeable for life at no additional charge. 

The "try before you buy" philosophy of open source 
combined with the idea that most software is free to use, 
gives you the freedom to find the right Linux distribution for 
you without spending money and with little to no risk.

Even if you choose a distribution that's designed for 
beginners, it is capable enough for even the most 
experienced computer user because, well, it's Linux! It has 
the power of every other Linux built-in. Simply put, it 
provides a powerful and practical alternative to other 
operating systems.
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Appendix F: Trusted Sources And 
Software Repositories Explained

 There are a few applications and terms used in 
Ubuntu MATE for finding, installing, and removing 
applications as well as updating your system. Here are a few
definitions that might help remove some of the mystery and 
confusion that some people experience when navigating the 
options for installing software on Ubuntu MATE.

Software Boutique

 The "Software Boutique" is a curated collection of 
applications and snaps, not the whole repository of software.
It is a quick and easy way of finding and managing software 
that the Ubuntu MATE team has identified as most popular, 
best in class, or simply a great choice for most users.

Apt And Apt-Get

 When you use the command "apt" or "apt-get" to find,
install, and update software via the command line in a 
terminal, you access the Ubuntu MATE repository of 
software including deb and snap packages. 

Software Updater

 The "Software Updater" is essentially a graphical 
front-end to "apt" and "apt-get" that works in the same way 
as the terminal commands -- with the whole software 
repository.
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Add-On Software Management Applications

 Support for Snap packages is installed in Ubuntu 
MATE by default and allows the "Software Center", the 
"Software Updater", and the "Software Boutique" to install, 
update, and remove snap packages. You can also use the 
"snap" command on the command line.

"Snap Store" is an application that can be installed from the 
command line as a snap package named "snap-store". 

sudo snap install snap-store
The term "Snap store" also refers more generally to the 
online repository of snap packages available at 
https://snapcraft.io/store.

 As of release 22.04, support for Flatpak packages is 
also provided by default and allows you to use the command
line to install "flatpak" applications from the flathub app 
center. Once support for flatpack packages is enabled in the 
Software Boutique, you can install flatpaks from the app 
center (flathub.org/apps). You can find the specific "flatpak" 
command you need within the application's listing in the 
flathub app center. 

 The application "Software" ("gnome-software") is a 
graphical application that can be installed from the Software 
Boutique and gives you access to the full Ubuntu repository.

 The application "Synaptic Package Manager" is an 
additional application that can be installed from the Software 
Boutique that gives you access to the Ubuntu repository. It 
provides some more advanced features than the Software 
Center or Gnome Software applications.
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Appendix G: Additional Resources

Ubuntu MATE Website And Community 

 If you are looking for help and can't find the answer in
this book, many more answers are available in the vast 
resource that is the Ubuntu MATE website.

The Ubuntu MATE website, located at https://ubuntu-
mate.org provides a wealth of information. It provides lots of 
details about the operating system and even a few 
screenshots to give you a feel for how it looks.

Often, posing your question to the friendly and helpful 
Ubuntu MATE Community is the fastest and easiest way to 
get answers about how to use Ubuntu MATE. Join the 
conversation and get involved. Stop by to share your 
experiences, ask questions and discuss topics with other 
users and developers in the Ubuntu MATE community. You'll
find it located at https://ubuntu-mate.community/.

Ubuntu MATE Guide Online

 The Ubuntu MATE Guide, described in a previous 
section and accessible from within Ubuntu MATE, is also 
available from the Ubuntu MATE website. You can preview 
the current release of Ubuntu MATE even before you install 
the operating system. You can find the online version of the  
guide at https://guide.ubuntu-mate.org/.
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Going Linux 

 If you need a little advice on how to get started with 
Linux, or how to get better with it, the Going Linux website 
and podcast are designed to help you discover what you 
need to know to do just that. Whether you enjoy reading 
about tips and tricks or listening to a couple of Linux users 
like yourself, you'll find these resources a refreshing 
alternative to similar commercial offerings that are more 
formal and less friendly. As a new Linux user, you'll have a 
friendly way to learn what you need to improve your 
competence with the software. As a more experienced user, 
you'll improve your confidence with Linux and its 
applications. As an old hand at Linux, you'll discover new 
ideas, solve problems and have a reference for helping 
yourself and others with the day-to-day use of the operating 
system.

If you learn best by reading, or you are simply interested in 
using our services, visit our website at 
https://goinglinux.com, read our articles and/or download any
of our books and guides written specifically for Ubuntu 
MATE.

If you learn best by hearing others discuss interesting topics 
in an everyday conversational way, subscribe to the Going 
Linux Podcast using Apple Podcasts, Stitcher, Rhythmbox, 
or other application that lets you receive podcasts. 
https://subscribe.goinglinux.com.

If you learn best by seeing videos on how to do something, 
then check out our screencasts at 
https://screencasts.goinglinux.com.

If you are looking for an introduction to switching from other 
operating systems to Ubuntu MATE, you can order a 
paperback copy or download an e-book version of the 
second edition of Ubuntu MATE: Upgrading from Windows 
or macOS, a paperback written with examples from Ubuntu 
MATE 20.04.
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Appendix H: About The Author
Larry Bushey's goal is to help you build your confidence and 
competence using cloud, open source, and commercial 
software. His broad background in business consulting, 
technology management, project management, education, 
public speaking, leadership, and sales gives him a unique 
perspective on using today's technology to get things done. 

In his professional role, consulting for a cloud computing 
company, he draws on 20+ years of experience designing, 
deploying, and educating on large-scale technology. 

As creator, producer, and host of top-rated technology 
podcasts since 2005, he and his co-host, Bill Smith, help 
computer users with practical advice on how to get the most 
from their corporate and personal technologies and software 
applications. 

As a technology advocate, he contributes to the Linux and 
open source communities by authoring documentation and 
writing manuals, guides, and books -- like this one! 

Other Publications By This Author

 Using Ubuntu MATE and Its Applications: 
Ubuntu MATE 20.04 LTS (3rd Edition) - Released February 2020 
https://www.amazon.com/dp/ASIN/B084DFZMFC

 Ubuntu MATE: Upgrading from Windows or macOS 
Ubuntu MATE 20.04 (2nd Edition) - Released January 2020 
https://www.amazon.com/dp/ASIN/1658872681

 Ubuntu MATE Guide - Online 
https://guide.ubuntu-mate.org

- 158 -



How To Contact The Author:

 LinkedIn: https://www.linkedin.com/in/larrybushey

 Twitter: https://twitter.com/goinglinux
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